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WeavePoint License Agreement and Warranty
Program License
You have the non exclusive right to use WeavePoint on a single computer.
You may not install this program on more than one computer, or use it over a network,
without the written permission from B.T. Myhre by a multi-user, network or site
license.
As an exception to the above, you may install this program on more than one computer,
as long as it under no circumstance is used on more than one computer at the same
time. For example, if you have one computer at the workshop and one at home, you can
use the program on both computers, but only if no other person can use the program in
the workshop when you may use it at home. If more than one person want to use the
program independently, each user must have a license.
You may not modify or translate the software in any way or manner.
No part of this manual may be reproduced or transmitted in any form or by any means.
Electronic, mechanical, by photocopying or otherwise without the prior written consent
of B.T. Myhre.
Backup and Transfer
You may make one archival copy of WeavePoint for the sole purpose of backing up
the software for your own use.
You may sell the program with your license right to another party. If you sell your
license, you must transfer the complete program with disks and documentation,
including any existing backup copy. You also need to notify B.T. Myhre about the
transfer, to make the new owner get upgrade rights for new versions.
Limited Warranty
With respect to the physical diskette and physical documentation, B.T. Myhre warrants
that these items will be free from defect in materials and workmanship in a period of 30
days. In the event of notification within the warranty period, the defective diskette or
documentation will be replaced, so long as you mail the defective item to B.T. Myhre.
Except for the above limited warranty, this software is provided "as is". The entire risk
as to the results and performance of the program is assumed by you. B.T. Myhre makes
no warranties with regard to performance, accuracy or reliability of WeavePoint and
disclaims any warranties of fitness for any particular purpose. B.T. Myhre shall not be
held responsible for any consequential or other damage that may possibly occur through
the use of this software.
Trademark
The name WeavePoint and the WeavePoint logo are trademarks of B.T. Myhre.

Installation
Insert the program CD into your drive and the installation dialog window will pop up
automatically.
If you do not see this window, it’s probably because autorun is turned off on your CD
drive and you will have to start the installer manually. To do this, open the contents of
the CD in My Computer or in an Explorer window and double-click on Setup.exe
After the program is installed, you can start it from the Start menu, or by doubleclicking on the desktop icon.

System Requirements
Windows 98/ME/2000/XP/Vista/7.
Minimum Hardware Requirements:
Standard requirements for your Windows version
5 Mb free disk space.
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Introduction to WeavePoint v. 7
WeavePoint lets you quickly produce patterns and colorways for all the main loom systems, from tie-up
and table looms to industrial shaft looms, and is a very efficient tool for trying out new ideas and
techniques in a systematic way. The graphics user interface is fast and easy and gives a clear view of all
parts of your design.
WeavePoint is made to fill the requirements of the experienced designer. But also if you are learning or
teaching, this program is very useful since so many design principles are built into the program. The
Design Mode can even be used for knitting and other repetitive grid patterns. For using WeavePoint in
production, interface options for various loom control systems are available.
WeavePoint is designed with the philosophy in mind that your time is best used for studying patterns, not
for studying computers and manuals. Still, it is recommended to read through the documentation in these
chapters, to get the most out of the program.
To get context sensitive help on menu items and in dialogs, press F1 when highlighting a menu item or
when a dialog is open. Also, you can click the Help button available in many dialogs.
When the cursor is over a menu item or toolbar button, a short description is displayed in the status bar
for most items.
A collection of sample patterns is installed to the Samples folder. These patterns are examples of various
types of patterns, profiles, and networking components. The Samples folder is located in your
Documents/WeavePoint folder and also, by default, in C:\Program Files\WeavePoint 7\Samples.
The Project Planner is a separate utility that is included with WeavePoint. The Project Planner lets you
easily calculate yarn weights and costs for a project. See Chapter 12, on the Project Planner, and Help in
the Project Planner for further instructions.
Be sure to check out the WeavePoint home site on a regular basis for news, tips and other information:
www.weavepoint.com.
Following is an overview of the various tools you will find in the Draft and Design Windows, to help you
get started. Find more, detailed information in the chapters of this manual associated with each item in

WEAVEPOINT BASICS
Main Window
The main window is the Draft View. This is the default and will automatically open when the application is started. At
the top is the Tool Bar and at the bottom is the Status Bar. Following is a brief explanation of each Speed Button and
other features and tools within the Draft View. Look in the relevant Menu Chapters for more information.
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Fig.Intro.1

The Tool Bar
The Tool Bar gives quick access to frequently used commands. In addition to the standard Open File and Save
buttons are Speed Buttons for accessing various tools and dialogues.

Speed Buttons
The Tool Bar contains Speed Buttons for quickly selecting some commands that are frequently used. Place the mouse
cursor over a button to see a hint about its function.

Browse
The Browse button will open a window to allow the search for your WeavePoint files, shown as
thumbnails, for easy identification. This is also available from the File Menu.
Pen Tool
This Pen Tool is used facilitate the entry of irregular selections in the Draft and Design Windows; for example, entering
irregular twills in the threading or shaping forms in the lift-plan. **Tip – a left click will enter a selection, and use
the right mouse button to erase.

Line Tool
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The Line Tool is used to facilitate the entry of linear selections in the Draft and Design Windows; for example,
entering Straight or Pointed Twills.

Selection Tool
The Selection Tool will enable you to click and drag with your cursor to highlight and encircle areas on the Draft
which you may then copy, paste, delete, or otherwise change. When using the Selection Tool in Design Mode, the
selected area will be darkened to more easily see the selection (the darkest colors will be affected to enhance their
viewing while selected).

Toggle Threading
This will eliminate the Threading and Tie-up sections from the window. Simply reselect the button to
bring back the missing sections.

Change Face
This tool will immediately change to view the back face of the fabric in the Draft Window, the Fabric and
Interlacement Views.

Repeat
Having used the Selection Tool to make a selection, open the Repeat dialog and your choice will
be reflected in the active boxes.
As long as you know, specifically, which area is to be repeated, there is no need to use the
Selection Tool in advance. Simply enter the starting and ending point defining the repeat and
whether to fill the entire grid on only a certain number of repeats.
Zoom
Click to the left or right of the Slider to increase or decrease the zoom . Also, pressing the page up/page
down keys on your keyboard will produce the same effect. The full size of your pattern depends on your
Options settings. Maximum size is 9600 warp ends and 9600 weft picks. To view more ends or picks than
presented on the screen, you can either set a lower zoom level or scroll the window. When setting a lower

zoom level, a larger part of the pattern will be displayed. The components will diminish in size to fit
the screen.
Notes – changes position on Toolbar so order is changed here as well
This button will open a window for writing and maintaining notes for the selected Draft. If no
information has been entered in the window, the icon/page will appear blank. Once information has
been entered in the window, little lines will appear on the icon/page.
Options
This button gives instant access to the Options Window. In this window, select ing
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the Loom Tab will give you the tools to choose the appropriate selections for
your loom: either Liftplan or Tie-up and Treadling; as well as selections for Single
Treadle or Multiple Treadle Tie-Up; Rising or Sinking Shed; and the number of
Shafts and Treadles, as well as the number of ends and picks.
Liftplan is used for dobby looms, industrial shaft looms, table looms - all looms
with direct shaft control. In Liftplan Mode, the rising/sinking of shafts is decided
in the liftplan (also called “peg plan” or “chain draft”).
Tie-up system is equal to countermarch or sequence of lags. Tie-up with multiple
treadles allows pressing two or more treadles at the same time, making what is
called a “skeleton treadling”, and should be used only when this is needed. Note:
Design Mode and Drawdown Editing are not available in Tie-up Mode with multiple
treadles.
Other Tabs in the Options window include the Layout, Style, and Grid Tabs; for changing the
arrangement of and selecting components for the Draft Window and other Miscellaneous settings.
This tool, in the Layout Tab, will allow you to insert numbers and/or colors in the grids.
The Grids function as an overlay/guide for the pattern. Selecting from the variety of options on the
Grid Tab, one can set the visual cues of the grid lines to optimize the visual information in the Draft
Window.
Draft/Fabric
This button will instantly switch from the Draft Window to the Fabric View.

Fabric Options
This will open a dialog box which will enable you to set the Fabric Density in the Fabric View. This
information will affect the appearance of the in the Fabric View.

Yarn Info
This button will open the Yarn Dialog window. Information on the yarn, its size and spacing,
symbols for representation in the Draft display, and other tools will assist you in the design and
production of your textile. This information will be important in building the Fabric View of
your textile.
Color Box & Drop-Down Menu
Click on the Color Box to open the Color Palette Window. This will display all of the colors in the
Palette for the draft. The Drop-Down Menu displays the currently selected color (and its number) for
drawing colors in warp color and weft color grids. Click the arrow to display all colors in the drop down
box. Click on a new color to change the active color selection.
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Notes
This button, a little page icon, will open a window for writing and maintaining notes for the selected
Draft. Little lines will appear on the button/page, if notes have been entered. Otherwise, the little page
icon will remain blank.

The Status Bar
The status bar at the bottom of the screen tells you the start and end positions of the warp and weft
sections as shown in the current window. The location of the cursor is indicated by a cross reference of
the warp (End) and weft (Pick) and will change as the cursor moves across the fabric in the drawn down.
When the cursor is in the warp or weft color strips, the End or Pick number and the color index number
will be displayed.
The left side of the status bar shows a helping hint when choosing a menu item or speed button; or, when
making a selection, the number of Ends or Picks in the selection will be displayed at the left side of the
status bar.

Numbering
Between the Threading and Treadling Grids and their respective Color Bars, numbers for identifying
placement in the over all draft are located. Placed at the Grid Marking Lines, at intervals of eight, they
will enable you to judge your location in the draft, even when you have set Zoom to the closest setting.
The numbers are visible in Zoom level 7 and up (to 20).

Making Repeats
You only need to fill in one repeat in a diagram. Then let the program do the work of repeating it!
Repeats can be made in various ways. Normally you will use the Repeat command. If you have drawn
one repeat, just click Repeat and check Fill Pattern. Or uncheck this and set the number of repeats. You
can also use Copy and Paste Special.

Two Ways to Design: Program Modes
In the program, you can work in several different modes depending on what you are doing. In the menus,
you will note that some items will be disabled, according to the mode in effect. A disabled menu item is
gray in the menu and can not be selected.
With WeavePoint, you can make a pattern in basically two ways. First there is the normal Draft Mode,
which is when the threading and other drafting components are present on the screen. Then there is
Design Mode, where only the pattern grid and the color diagrams are viewed on the screen.

Turning Drafts into Files
One of the most important things to know, as you develop a library of patterns, is the location of the
Folders where you save your Files. In the Save Dialogue Box you can determine into which Folder to
keep the draft (Look In part of the Box), the name of the Draft-as-File (File Name part of the Box), the
type of file (Files of Type part of the Box) which will be .wpo or .wif.
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The Location of your saved files may be thought of just like your residence address, with a general
location (your City), your street address, and finally, the number of your house or apartment. Each step
gives a more precise location for your File and will be described, generally, by three things:
1. The Primary Location – like your city, this is the general area of the computer in which
the file will be located. Your selection will be made by highlighting one of the locations
shown in the vertical window on the left hand side of the Open Dialogue Box. In this
example, My Documents has been selected. Use your cursor to select another, such as
the Desktop, if you wish.
2. The Secondary Location – like the name of your street, this Folder will show in the Look
In: drop-down window at the top of the Dialogue Box. You may choose another location
by clicking the arrow and highlighting one of the other locations shown in the drop-down
list or you may choose to open a file that is listed in the central window, by doubleclicking on it. In this example the Folder is “WeavePoint v6”.
3. The Final Location – like your street number, this is the final location (unless you use a
sub-folder here) and it will be listed in the large central window of the Dialogue Box.
Here it is shown as a WeavePoint file: “Test Image.wpo”.
The File Name will be listed, with any other extant files/patterns, in the large central window of the Box.
To open the File, you may double-click on the icon next to the name or click once to highlight the icon
and then click the Open button. When you have selected the name by highlighting it, the name will
appear in the File name: box, the second drop-down menu from the bottom center of the box, just above
the Files of Type. If you are saving a new pattern/file, for the first time, this is where you will enter the
name. You will want to develop some form of description for your patterns, to help you keep them
organized. You may use as many as 255 characters in the name. (There will be more on New Files and
Saving and Sending Files later, see below).
The Type of File determines the manner in which the file may be accessed and used in the future. The
files that will be visible in the central window of the Dialogue Box will be determined by your selection
from the Files of Type: drop-down menu at the bottom center of the Dialogue Box. The choices will be
WeavePoint (.wpo), Bitmaps (.bmp), WIF files (.wif), or Any Files. If you select WeavePoint files, then
the list in the central box will be limited to all Folders and only WeavePoint files. If you select WIF files,
again, you will be limited to Folders and only WIF files. Selecting All Files will allow you to see all of
the files included in the Folder, not just one specific type.

WIF Files
Each of the various weaving programs available each uses its own format for storing weave information,
such as .wpo for files made in WeavePoint. Each format is especially suited to the individual program.
In most cases, it is not possible to open a pattern saved in a different program.
WIF (Weaving Information File) is a common file format for weaving programs. WeavePoint follows the
WIF version 1.1 specifications which were agreed upon by the developers of the major weaving programs
in Spring, 1997. WIF files are ASCII text files which you also can open in a text editor like Notepad and
can also be understood by a human reader.
WIF allows different programs to share common weave information and is now supported by many
weaving programs. Using WIF, you can exchange weaving patterns between different programs. If you
want to use more than one weaving program, you can, for example, start making a pattern in one program,
and then continue editing in another program. Or use another program for weaving with loom control.
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WIF also makes it possible to exchange weaving patterns with a friend who uses another program and to
transfer files by email.
Opening WIF Files: Open the WIF file as you would any other file. The WIF file can contain liftplan,
tie-up/treadling, or both. If both, the liftplan will be loaded if you are presently in Liftplan Mode; tieup/treadling will be loaded if you are presently in Tie-Up Mode. A WIF file can contain text information
which will be placed in the note.
Note that WIF is an inefficient file format. A very large WIF file, with thousands of ends and picks, can
take a long time to load.
To Save as WIF File: Choose Export/Save to WIF file. The WIF file will be saved with liftplan if you
are in Liftplan Mode and tie-up/treadling if you are in Tie-Up Mode. If Save in both Tie-Up and
Liftplan format is checked, both liftplan and tie-up/treadling will be stored. If there is some text in note,
it will also be stored in the WIF file.
Select the number of ends and picks to save. Often all you need to save is one repeat. This will help to
minimize the inefficiency of the file.
If you have received a WIF file, note that while you can open the file like any other pattern, you must
save it on your computer as a file in your weaving program in order to be able to access its components
through the controls in the Transform Menu (see the chapter on the Transform Menu for more details).
Sending WIF Files with E-Mail
A possible problem, when sending WIF files attached to an e-mail, is that because it is actually a text file,
the line endings can be changed or corrupted in a way which makes it unreadable in weaving software.
The solution is to send the .wif file in a .zip file (or another compressed format). When zipped, you can
be certain that the file's integrity will be protected. If you have received a problem file, you can try to
clean it by opening and repairing it in a program like Word, being sure to save it as a .wif.
To create a .zip file, right click on the file, choose “send to” and select> Compressed (zipped) folder.
Then send the folder as you normally would. To receive and open a .zip file, the recipient will right click
on the folder and chooses Extract.

Bitmap Files (.bmp)
A bitmap will open in Design Mode. If it is sized correctly, it can also be opened in Tie-up and Lift-plan.
Note that one pixel in a bitmap becomes one square in WeavePoint, so a bitmap that looks small in a paint
program may appear much larger in WeavePoint. The maximum size of your bitmap file (.bmp) is 9600 x
9600.
Bitmaps can be monochromatic, 16 color, 256 color, etc. WeavePoint treats bitmaps as monochrome.
Because the colors are in the threads, the drawdown structure is essentially red/white (over/under). For
example, all of the warp will be red and all of the weft will be white. So, just like with any drawdown, an
exposed warp end will show as red in the square and an exposed weft will be white.
Most paint programs are set up as default to save multi-color bitmaps. You can load color bitmaps, but
the background should be pure white. All other colors except white are seen as red, so you need to use
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100% white as one color in the image. Then you can use any other color as black. Alternatively, paint
and save your image as a monochrome bitmap before loading it in WeavePoint.
Draft View Options
There are two way to view and work on your draft. From the View Menu, select Draft. In the Options
Menu, select the Loom Style, These two choices will determine the window in which you will be
working.: whether Tie-up (showing the combinations of harnesses to treadles and the order for treadling
the pattern) or Liftplan (showing the combination of harnesses to lift for each pick).
Once these selections are made, in this View you will fill in the different components, like threading, tieup, treadling. The program will then automatically construct the drawdown. Once a pattern is made, you
can edit and modify it using any number of tools provided in the program.

Fig. Intro.2
Main Window/Draft View - Treadling & Tie-up
If you are working in the Draft window, in Liftplan Mode, you can also draw directly on the drawdown.
Once the threading is filled in, as you move (click and drag) your cursor over the drawdown area, the
program will automatically construct the liftplan. When you then switch over to Tie-up Mode, the
Liftplan will automatically be converted to treadling and Tie-up.
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Fig.Intro.3
Draft View - Liftplan
In the Design View, you can draw your pattern directly into the grid. The Design View is used for
drawing a pixilated pattern; each square will represent either an exposed warp end or weft end, whichever
is to be on the cloth surface. The Design Mode/View may be accessed at any time from the View Menu.

Fig.Intro.4
Design View
To enter Design Mode, choose View/Design. To enter Draft Mode, choose View/Draft.
Note that if you have a pattern in Draft Mode and change to Design Mode, you will be asked first to save
the pattern. When the Design Window opens, the pattern will be automatically reduced to one repeat, to
make it easy to work on the pattern. Choose Repeat with Fill Pattern checked to fill out the Design
Window with the single repeat.
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Additionally, a third way is to put together a design by loading elements from different patterns, using the
Open Components command.
In addition, other fabric view modes are also found in the View Menu: Fabric, Drapery, and
Interlacement.
Fabric Analysis
To analyze a woven cloth, examine the cloth and plot in the interlacement pattern in Design Mode. The
program will construct the threading and other parts of the draft when you change to Draft Mode.
Optimizing a Design for the Loom
If you have constructed a design by filling in the draft, you will have chosen to use a certain number of
shafts. If you would like to see if it would be possible to weave the pattern with less shafts, choose
Transform/Reanalyze.
If you enter Design Mode and then return to Draft Mode, a reanalysis will be performed automatically.
A Quick Tutorial
This is a quick tutorial on how to make a pattern in Draft Mode.
be covered in detail in the appropriate sections of this manual.

Please note that all of these points will

First, pick File Menu/New from the menu to start with a blank draft. In the New Pattern dialogue box,
you can select the number of shafts and rising or sinking shed (depending on the action of your loom).
At start-up, the program will be either in Liftplan Mode or in Tie-Up Mode, depending on the present
settings. Check that you have the right kind of layout on the screen. If there is a tie-up grid in the upper
right corner, you are in Tie-Up Mode; if it is a series of right-angle lines, you are in Liftplan Mode. If
necessary, change loom system: Pick Options Menu/Options, select the Loom Tab (or use the Options
Speed button on the Tool Bar), and select your loom system.
When editing, the cursor position is continually updated in the status bar. You can change zoom levels in
the tool bar and click the scroll bars to move the window.
You can start drawing in any part of the draft, but it can be most effective to start with the threading. In
the tool bar, click the Pen button to draw in Freehand Mode and Line to draw lines. It is usually most
convenient to draw with Line Mode in the threading.
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Fig.Intro.5
Draft View – Tie-up Mode
To draw, position the cursor and press the left mouse button. Then drag out your line and release the
mouse button. If you want to correct warp ends, simply draw over what you already have drawn, and the
filled squares will move. It is easier to create straight lines, as shown in the window below, if you click
on the Line Tool. You can see, in this image, that it is highlighted in the Tool Bar. To undo your last
drawing operation, pick Edit/Undo or press Ctrl-Z. To erase individual ends, click the right mouse
button.
Fill in the threading until you have one repeat. If you want to make it symmetrical quickly, select
Utilities/Make Symmetrical/Warp.
Now you can fill in the liftplan or tie-up, depending on the mode you work in. Click the left mouse
button to draw and the right mouse button to erase.
If you’re in Tie-Up Mode, fill in one repeat in the treadling. You can fill the remaining picks in the same
manner as filling in the threading (see above). Another option is to select Utilities/Tromp As Writ; this
will copy the threading to the treadling.
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Fig.Intro.6
One Repeat in Treadling, Threading with Tie Up
Now to fill the pattern with your repeat, click the Repeat button on the tool bar, check Fill Pattern, and
click OK.
Next, you can select different warp and weft colors. Right now the Warp is all red and the Weft is all
white. This is the default setting. To change the colors for this draft, pick Yarn/Color Palette to open
the Color Palette window; or, select colors in the Color Box on the Tool Bar. Select a color and either
click and drag, to change several contiguous ends, or click on each small square in the Color Bar, to effect
the change. To repeat the colors, select Repeat, uncheck Fill Pattern, and check Warp Colors or Weft
Colors and choose the part to repeat in the Repeat Source field and check Fill Remaining.
That’s how easy it is to make a pattern. Now you can try to display it with some of the views in the View
Menu. Try Fabric, and Interlacement. And try printing your pattern, for example, as draft.
Shortcuts
Additional time can be saved by learning and using these Keyboard Shortcuts for some of the Tools
mentioned here:
Press the S key to change between Pen, Line and Select Modes.
Press the M key for Select mode (marking mode).
Press the L key for Line mode.
Press the P key for Pen mode (freehand mode).
Press the D key to switch between Draft and Design Mode.
When working with Color, you can change the color applied with your cursor by holding it over a
different color in the Color Bars and right clicking with your mouse.
Other information about WeavePoint
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You can also quickly create patterns by using elements from the Fill Menu. If you are in Tie-up Mode
you will be able to select one of the three basic patterns for threading and treadling. Then you can select a
twill variation, satin, or tabby. If you are in Liftplan Mode, only the threading and liftplan will be
available.
Under the Tie-up and Liftplan items in this Menu, you can select the Twill Variations Dialogue Box.
Each time you toggle the Generate Twill bar, the tie-up or liftplan will change and a new twill pattern will
be displayed. Select OK to keep a pattern.
Remember, as you create your design, to Save it (File/Save or Save As). The first time you Save a
pattern, a dialogue box will open, giving you an opportunity to name your pattern and choose the location
for keeping this and future designs. The pattern name can have as many as 255 characters, so you can be
as detailed as you wish!
Also, as you develop a pattern, you may wish to Save As, in order to continue to diversify your draft and,
if you choose, revert to the original pattern as saved.
Check out the sample patterns that have been included with your WeavePoint software.
Now you can continue to explore the program on your own. The following Sections will explore each
Menu in detail. Try Copy and Paste. And check out the How to... section. Try out all the possibilities in
the Utilities and Transform Menus. Many of the Dialog Boxes will have Preview Buttons to allow you to
explore possibilities without making permanent changes to your pattern.
WeavePoint, upon re-opening, will remember the size of the window you were working in previous to
closing, instead of always opening in full screen. This is especially useful with large and wide screen
monitors.
Help Menu
To bring up Help on a menu item, place the cursor over an item in a menu and press the F1 key on your
keyboard. You can also press F1 in dialogues.

Sample File
The CD-Rom which you used to install this application also contains a separate folder labeled Sample
File. This contains many weave patterns that you can use to help get started. Simply copy this file onto
your desktop or hard-drive open them using your WeavePoint software.
BACK-UP
Be sure to Save your WeavePoint files to a separate disc or flash drive, on a regular basis! This
way, if your computer should experience a fatal event, you will not loose all your files/designs.
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FILE MENU

File/Menu

File/Open
If you wish to open a file that you have recently opened, double click on the file name from the list at the bottom of
the Menu to open it. This list contains links for the previous seven files you have opened in WeavePoint. If you do
not see the pattern you are looking for, choose File/Open or click the Open speed button to go to the Open
dialogue box.
If you browse your computer to open a pattern, the program will remember the original location of that folder and
open for any subsequent SAVE AS to the same folder.

Fig.1.1
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Display More than One Pattern
To see and work with more than one pattern at the same time, you can simply run more than one instance of the
program - just select to run it again from the Windows/Vista Start Menu. Place the program windows side by side to
compare patterns. You can also copy in one program window and then paste in another program window.
You will see one icon for each instance on the Windows taskbar - this icon will also show the present pattern name in
each program window.
To switch to another WeavePoint window (that is, another instance of the program running), click on it in the taskbar.
To arrange the WeavePoint windows on the screen, right-click on any blank space in the taskbar, and select from the
submenu. If comparing two patterns, Tile Vertically lets you see more weft and Tile Horizontally lets you see
more warp.

File/Browse
This selection will open a dialogue box displaying all your WeavePoint files (.wpo) as thumbnail images.
You can also access this dialogue box using the Browser Speed Button on the toolbar.
In the Browse window, click the yellow folder icon to select a folder. Recently used folders can be
quickly selected in the bar just below the folder icon.
The Sort drop down box will allow you to sort by Name, Date, or Number of Shafts/Harnesses.
There are three Zoom levels; Three providing the largest view and One, the smallest.

Fig. 1.2
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File /Open Components
When you save a pattern, all pattern components are saved in one file: threading, liftplan (or tie-up and treadling in
Tie-Up Mode), warp colors, weft colors, color palette, and transform weave units. Once you have opened a File or as
you build or change a pattern, you may wish to select one or more components of a different pattern file to load into
the present pattern. For example, you may want to use the color palette from another pattern.
To load separate pattern components instead of the whole pattern, choose File/Open Components. A search
window will open. Locate and select the file with the particular component you desire to load into the current
pattern. Once you have selected the file, the Load Components dialogue box will open, asking which component/s
you wish to load into your pattern.

Fig. 1.3

Fig. 1.4
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The component you load will replace the entire present component with one exception: when loading a liftplan or
tie-up, it will replace only the number of shafts (and treadles) that are in the loaded component. For example, if the
current number of shafts (or treadles) is greater, the remainder will be left intact. In this way, you may put two
liftplans or tie-ups side by side.
When you’re working in Liftplan Mode and open a pattern saved in Tie-Up Mode, Liftplan in the second file will not
be available to you, as there is no liftplan saved in the file. Likewise Tie-Up and Treadling will be unavailable if
you’re in Tie-Up Mode and open a pattern saved in Liftplan Mode. You will have to go into the other file and convert
it to the desired Mode.
Note that “Trans. Units” refers to Transform Units. Creating, using and opening Transform Units is addressed in
greater detail in the Chapter on the Transform Menu (See Transform Menu/Translate and Transform
Menu/Overlay).
Select one or more components of a pattern file to load into the present pattern. For example, if you just want to use
the color palette from another pattern, check Palette in the dialog. The components you open will replace the
present contents of these components.
Blend Liftplan
Clicking Blend Liftplan will bring you to another dialog where you can select four different ways to combine the
liftplan selected with the current one:
Append
Appends the liftplan you open to the end of the existing liftplan.
Add
Adds all filled squares in the loading liftplan to the current one.
Invert
Each filled square in the loading liftplan will show as a filled square if it was not filled earlier and an empty square if it
was filled.
Subtract
Each filled square in the loading liftplan will produce an empty square in the present liftplan.
Hint: Reversing one of the liftplans before using blend opens for a variety of new results.

File /Save
Choose File/Save or click the Save speed button to save the present pattern with the present name and path (folder)
and any changes made since opening the file. The name and path of the present pattern is always displayed in the
program title bar.
If you are working on a .wif, it will show as such in the title bar. You must Save AS to create a new .wpo file.
When saving, the complete pattern is saved (whether filled in or empty), including the current color palette, notes
and transform weave units.
When working in a New File, if you have not attempted to Save, the Save As dialogue box will be opened
automatically if you select Save or choose to close the window.
Suggestion: If you are only really interested in saving one component, you do not need to care about how the other
parts are filled in. When you later want to load the component, you just select to load only the component you want.
For example, to save the present color palette, just use Save or Save As. Choose a file name like “Bright Colors 1”
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to remember what the file contains. You can then later use the various pattern elements as building blocks when
constructing a new pattern. Or use them in various Transform Menu commands, like inserting a threading from file
or loading weave units from file.

File /Save As
Here you can create a new pattern name, or path to a new storage place or create a new folder to save it in.
If you are saving a new pattern/file, for the first time, this is where you will enter the name. You will want to
develop some form of description for your patterns, to help you keep them organized. You may use as many as 255
characters in the name. This gives you room to use spaces and be very descriptive in your file names.
Remember to choose an appropriate location (folder). Here again, it is important to understand and remember how
and where to save your files! To save to another drive, the desktop, flash stick or other storage device, make sure you
select the appropriate location on your computer.
If names of any file are too long to show in the presented window, the dialogue box will show horizontal and vertical
scroll bars. Note also that not all of the name will always be visible, depending on the size of the monitor, nature of
the Dialogue Box, format of the email server, etc. So you may want to limit file names to something like thirty or
forty characters.
If a pattern with the name already exists, you will be prompted to verify that you wish to overwrite the existing file.
So, if you want to preserve the original file and save this new one with the changes, you might want to add a number
or letter (for instance, 1 or A) which will change it enough to create a new file.
Another useful thing to do is to save a pattern file as a template for a new pattern. It can be convenient to have a
more or less empty pattern with, for example, just the right number of shafts, a palette of your choice, and maybe a
threading filled in, and then continue from there. When starting from a template file, remember to save your pattern
with a new name, to not overwrite your template file.
Files saved, stored and transported as WeavePoint (.wpo) files can only be used in yours or another WeavePoint
program. So, if you plan to share your files with owners of other types of weaving software, or plan to email your
patterns, then it is necessary to save them as .wifs.
Files can also be saved as - PNG Images, to open edit or print large patterns in other programs, like graphics/photo
programs.

File /Export
This option allows you to export the pattern to be saved in other file formats.

Export/Save to WIF file
A Dialog box will open. The WIF file will be saved with liftplan if you are in Liftplan Mode and the tie-up/treadling
if you are in Tie-Up Mode. If Save in both Tie-Up and Liftplan format is checked, both liftplan and tieup/treadling will be stored. If there is some text in note, it will also be stored in the WIF file.
Select the number of ends and picks to save. Often all you need to save is one repeat. This will help to minimize the
inefficiency of the file.
If you have received a WIF file, note that while you can open the file like any other pattern, you must save it on your
computer as a file in your weaving program in order to be able to access its components through the controls in the
Transform Menu (see the chapter on the Transform Menu for more details).
For more information on .wif files, see Chapter 1, WeavePoint Basics.
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Fig. 1.5

File /Export/Save Draft or Fabric as PNG Image
Use this command to save an image of the fabric or draft as a graphic file in PNG format. Specify the number of ends
and picks you want to include in the picture.
PNG files are effectively compressed to be as small as possible, but without any loss of image detail. PNG images can
be opened in most graphic programs, photo and paint programs, word processors, etc., and is also used on the web.
If you'd like to show some fabrics on your website, you can save them as PNG images and put them up on your site.
Saving as PNG images is a nice option, if you want to open fabric images in other programs, especially for large
patterns. Two benefits you can get with saving as PNG images, compared to capturing the screen image in fabric
view are:
1.)
If your pattern is so large that it cannot fit on the screen, even with a small zoom level, you can still save the
complete pattern to a PNG file.
2.)
If PPI and EPI are different, the PNG file will be stretched so that the aspect ratio between warp and weft
will be correct. This is done in a different way than in fabric view, so that the image will be as small as possible.

File /Revert to Saved
Revert to the present pattern as when last saved. This is a quick way to undo the changes you have made to the
pattern since you last saved it.

File /New
Select this item on the File Menu to start a new, blank pattern. The new pattern will replace the present pattern in
the window.
In the dialogue box which opens, you will be asked to enter certain settings. Other settings can be selected in the
Options Menu/Options dialogue box and the Color Dialogue Box.
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The new warp and weft colors will be reset to 6(red) and 0(white), because this is the default setting (more on
changing these settings in the chapter on the Transform Menu). Whatever changes you may have made to the color
palette will remain in place and will be available to use in the new one.
If Use Default Color Palette is checked, the color palette will change to the default palette and any palette changes
you may have made previously will not be available in this new pattern, unless you introduce that component into the
new pattern (more on that in a later chapter).

Fig. 1.6
Older versions of WeavePoint use a slightly different file format and you need to export to this format if you want to
load the pattern in any of these older versions of WeavePoint.
For information on the WIF format, see Working with WIF files in WeavePoint Basics.

File /Page Set-Up
This dialogue box will enable you to select the paper size, set margins, select the layout, and choose the printer.
Set paper margins to select both the placement of the printed image on the paper and the size of the printed image.
The margins setting affects all graphics printing, but not numeric printing. The rectangle, on the white paper
displayed, shows the selected printing area. When setting margins, you not only select the placement of the printed
image, but also, in effect, its size. To print the largest image possible, set all margins to zero. Note that because most
printers cannot print on the edges, a small margin will still remain.
In Page Set-Up, you can also make other selections, like Portrait or Landscape format printing. And you can click
Printer to check your printer settings. In most cases, the printed image will fill the selected printing area either in
width or height, but not both. This is because the image to print has in itself a fixed width/height ratio and this ratio
will be kept when printing. For example, if you choose to print a draft with forty ends and twenty picks, the image
width will be almost double its height. If you want to print this as large as possible, choose Landscape format to
better fit the image to the paper. Only Print Fabric in true size will normally fill the total printing area.
The settings you make will remain in effect until you exit from WeavePoint. Next time you start the program and wish
to print, select Page Set-Up again to re-check these settings.

File /Print
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To print images of the draft, fabric, etc., choose File Menu/Print. You will immediately be given the choice of
Draft, Fabric, or Screen Image.
The date and time will be automatically added at the bottom of the print out.

Print/Draft
Opens the Print Draft a dialogue Box. This box contains a number of settings which will determine the
scale and type of information to be printed on your draft. You can choose to fill threading, liftplan, tie-up,
and/or drawdown. Note that the print out of your draft will be limited to one page, so the more ends/picks
you print, the smaller will each end and pick become on paper. If you wish to print large patterns, print
one part at a time (see information on setting for Ends and Picks, below). Please note: If threading is not
on display in the draft window on your screen (toggle the Threading speed button to return it), the
threading will not print.

Fig. 1.7

Scale will give you a full range of options. This will enable you to choose whether to print the Full Draft,
Only Threading or Only Liftplan. In addition, you may set the number of Ends per Inch, or Grid
Squares per Millimeter, depending on the setting you chose in Options/Options/Miscellaneous Tab.
The lower the number of Ends/Inch or squares/mm., the larger will be the elements displayed. For
example, set at 10 Ends Per Inch, you will only be able to view 46 ends and 68 Picks; however, if set to
20 EPI, the program will automatically reset to show 111 ends and 156 picks.
Or you may wish to set printing for Ends and Picks. With this setting, you can adjust the number of ends
and picks you wish to print; as well as the starting place for each (if not at #1) and the ending end/pick
number will be automatically calculated and displayed.
If Fill with Numbers is selected, whatever draft components have been selected will print out as numbers
in their respective grids, instead of the customary small, black box.
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If Fill with Colors is selected, what ever draft components have been selected will print with the
designated color for each particular end or pick, instead of the customary black. If you have also selected
Fill with Numbers, the numbers will be superimposed on the color squares. Select the Color and
Number options to ensure visibility when white or a very light color is used.
When Use Grid Colors is checked, the present grid color settings in Options will be used also for
printing. If this square is unchecked, all lines will be printed black. Note: if you do not have a color
printer and any of your grid lines are red, they will not show on your printed page. In this case, using
black or grey for your grid will be more appropriate (see the chapter on Options Menu). Printing with
color will allow the red grid markings to show and the color bars will print as well, to aid with color
placement at the reed.
To print Threading only, for best results:
1. Go to Page Set-up and select Landscape
2. In the Print/Print Draft window:
3. Select Ends and Picks
4. Enter the ends you wish to print (remember you are limited to one page, so the more
ends, the smaller the scale will be (and harder to read!)
5. Set Picks to 0.
6. Check the boxes for Fill Threading, Fill with Numbers, Numbers by Marking Lines, and
Note (if desired)
To print Liftplan or Treadling only (for best results):
1. Go to Page Setup and select Portrait
2. In the Print/Print Draft Window Select Ends & Picks
3. Enter the Picks you wish to print
4. Set Ends to 0
5. Check the boxes for Fill Liftplan/Treadling, Fill with Numbers, Numbers by Marking
Lines, and Note (if desired)
You can select not to fill grids when printing. This is very useful for making exercises for students to fill
in parts. In the lower left of the box you can also select the number of Copies you wish to print.
You can also print the note below the draft. This is an easy way to add text to a draft printout and to make
single page handouts and printouts for education, etc.

Print/Fabric
To print as fabric with various options, pick Print Fabric.
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Fig. 1.8 File
Choose from the following options in the window:
1.)
Select Size: select how many ends and picks to print. You can even print the whole fabric of
thousands of ends and picks on one page.
2.)
Actual Scale: If you have entered Yarn Information in the Color Information dialog box (See the
Yarn Menu, Chapter 8) the fabric will be printed showing the yarns in relative scale to each other. How
many ends and picks to be printed depends on paper size, margins, and size of the draft.
3.)
To print the fabric with a yarn look, check the Outline Threads box. When printing with this
outline option, the colors may appear slightly darker because of the shadow effects added to the threads.
Printing time will be affected by the size of the draft. Llarge fabrics (high number of ends and picks) in
yarn view can take a longer time.
Print/Screen Image
The third option is Print Screen Image.
To print Design, Interlacement and other views, use this command. Note that for printing drafts, the Print
Draft command prints in better quality with finer lines than using Print Screen Image and the Print Fabric
command gives more options for printing an image of the fabric. It can also be useful for looking at
complex liftplans, as the lines between filled squares are visible.
You can also display multiple tool windows and print them together. For example, have Interlacement
View displayed with Color Palette.
Set margins to control image size and placement. Note that the screen image is normally in landscape
format and you can select to print in landscape format to better fit the image to the paper making it
possible to print the image larger.
Note that if you have a window on top, for example the Color Palette, this will be printed on top like on
the screen.
To print analysis results in the Analyze Menu, click the Print button in the result dialogues.

File/Print Numeric
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Choose File/Print Numeric to print Threading, Lift Plan, or Warp Color information with letters and
numbers. You may find this way of printing useful for printing draft information for using when setting
up the loom or when weaving. Also, numeric printing lets you print long threadings, treadlings, and
liftplans over several pages with one command. Select how many ends or picks to print in the dialog box.

Print Numeric/Threading will allow you to print and read your draft by harness number, rather than
trying to read the placement of squares in a Threading grid.

Fig. 1.9 – Numeric Threading

File/Print Numeric/Liftplan This offers the same advantage at the Numeric/Threading.

Fig.1.10 – Print/Numeric Liftplan
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Print Numeric/warp colors can be very useful when warping with many colors.
Prints the number of ends per color through the sequence of colors for warping, using the number from
the Color Dropdown Menu, for reference. For example, in the figure shown below, the sequence of color
numbers would be 15, 1, 15, 1, 2, 1, 15, etc.; using only one end per color. If there were multiple ends of
one color to thread in immediate sequence, you would see the specific number of ends to thread, rather
than the -1- shown here. One line is printed for each color used in the warp. If the warp is a single color,
the information will be shown as a single line item; the color number will be followed by the total number
of ends.

Fig. 1.11 - Print Numeric/Warp Colors/showing one end per color throughout the sequence

File/Printer Setup
You can choose File/Printer Setup to check the selected printer and its settings.
Printing Colors
The colors you get in your printouts are the result of how your printer and printer driver handle colors.
The printer driver you use is usually either one supplied with your printer or one that was included with
Windows. Modern printer drivers normally produce good results, but sometimes are far from perfect
compared to what you see on the screen.
Matching screen and printer colors is a complicated matter because of the different nature of the two
mediums. Also, different PC monitors produce different colors. With some monitors you can even adjust
the color temperature yourself. And the light condition in your room can influence how you perceive the
colors.
To match colors, you need a good monitor. Old or inexpensive monitors often do not display colors
accurately.
If you are dissatisfied with the colors on your prints, first read the documentation that came with your
printer to see if you can improve results by changing the printer setup, paper type, etc.
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Some printers support the Windows Image Color Matching standard (ICM). In combination with a
calibrated monitor, this could improve the color matching.
If you want to make an extra effort to synchronize monitor and printer colors, special software is available
from various companies to help you match colors produced by your monitor and printer.
Note that with many printers, for example, inkjet printers, colors can vary with different types of paper.
Make sure to select the paper type you load in the printer set-up dialogue for your printer.
Some black and white printer drivers have problems converting colors to gray tones.
Printing to Laser Printers
Page printers, normally called laser printers, must have enough memory to produce a full page graphic at
the current resolution or the print will fail. This is not a problem specific to WeavePoint, but simply how
laser printers work.
Example: If your printer has 1 megabyte of memory, you can print almost a full page at 300 DPI (in
black and white).
If you think you have encountered this problem, try one or more of the following:
1.)

Reduce the printer resolution in the Printer Set-Up dialogue.

2.)

Increase the paper margins to print a smaller image.

3.)

Purchase more memory for your printer.

Note that ink jet printers do not have this memory problem because ink jet printers normally print line by
line, not the full page at once, and so does not require memory to hold the whole image.

File/1-7 (Previously opened files)
This last section of the menu will list the last 7 files that have been opened, enabling easier access to
recent work.

File/Exit will close the program
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Edit Menu
Please note that there are Preview and Cancel options in many of the Dialog Boxes
in this menu.
Edit/Undo
To undo the last drawing operation, choose Edit/Undo or press Ctrl-Z. This command is also available after most menu commands
from the Edit, Utilities, Transform Menus, and the Library.

Edit Menu
Undo is not available for complex features, therefore, it is a good idea to save your pattern before making major changes to it, for
example, by using commands in the Utilities or Transform Menus or before you change the color palette. Then you can quickly
undo the change by choosing File/Revert to Saved.
Edit/Repeat
Use this to repeat your pattern in Draft Mode or Design Mode.
For simple repeats, you can use the Repeat command instead of Copy and Paste.
When having selected an area, you can click the Repeat speed button or choose Edit/Repeat.
If you have just drawn one repeat and want to repeat this throughout the pattern, check Fill Pattern. This option is only available if
part of the present pattern size is empty. The pattern is filled in both warp and warp and weft direction.
In the liftplan, if you select an area less than the total width before selection Repeat, only the selected width will be repeated.
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Fig. 2.1
If you do not want to Fill Pattern (fill all grids) or if you have made changes to a pattern that was repeated before and now want to
repeat your changes throughout, select the part to repeat. First mark what you wish to select. Threading, Warp Colors, etc., and then
select start and end positions, and number of copies. When entering number of copies, keep in mind you already have one copy (the
feature should be called "how many more copies?").
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Fig. 2.2
If you have selected an area with the Selection tool, the area selected will be pre-selected in the Repeat dialogue allowing a quick and
simple repeat. This way you can visually select the area to repeat. You do not need to copy to the clipboard because the selected part
on screen is being used (see also Copy and Paste).

Fig. 2.3
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To use Cut, Copy, or Paste, first click the Selection tool in the tool bar. Note that the cursor changes so that you can easily see that
you are in Selection Mode.
Draw a rectangle around the part you want to select. Then click Copy or Cut in the Edit Menu. Copy will just copy the selected
part to the clipboard. Cut will do the same, but will also erase the selected area.
You can copy and paste both in Draft Mode and in Design Mode.
Edit/Cut
Select the area to delete with the Selection tool, and then choose Edit/Cut.
Deletes the selected area and copies it to the clipboard.
In threading, treadling, and color grids, the selected ends/picks will be deleted. In liftplan, tie-up, and design grids, the selected area
will be cleared.
Edit/Copy
This command will copy the selected area to the clipboard.
Edit/Paste
When you have copied or cut a selection to the clipboard, you can select the area where you want to paste it. Note that you DO NOT
need make this selection area equal in size to the area you copied to the clipboard. Whatever is on the clipboard will be pasted in its full
size. All you need to do before pasting is to select the starting corner for the pasting. Selecting one square in liftplan or one end in
threading will be sufficient. But it does not matter even if you select a larger area for pasting - the result will be the same.
You can copy and paste from grid to other grid. You can paste from threading to treadling and vice versa, or from the liftplan to the tieup. But note that regarding the color grids (warp colors and weft colors), you can only copy and paste within these grids.
Pasting from Other Programs: You can copy part of an image in, for example, a paint program and paste it in the liftplan or
threading. Note that the image you copy from must have a white background. Note also that one pixel in the image will be one square
in the liftplan.

Edit/Paste Special
Depending on the area of the draft in which you are working, there are four dialog boxes which will open.
First, select an area within one of the grid sections and select Edit/copy. Then select an area where you want to paste and choose
Paste Special. Note that you can only use Paste Special when the clipboard has a copy from the same part of the draft. For example,
first copy from threading, then Paste Special in threading. The dialog box that opens will be specifically for that area of the draft? in
which your selection has occurred.
When using Paste Special and pasting multiple copies, the distance between the starting point of the copy and the starting point of the
selection is crucial. The distance between these two points will be the distance between each copy pasted in liftplan and in Design
Mode. In the threading, treadling, and color grids, following copies will always be placed next to the first copy.
The location of the starting point depends on your layout style. The starting point will always be the corner of the selected area that is
closest to original (position 1,1) of the present grid.

Paste Special - Tie-Up
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When using Paste Special in a liftplan or a tie-up grid, you can apply the following features: Invert, Flip horizontal, Flip vertical,
Rotate, and Transparent.
For you experienced WeavePoint users, Flip is similar to the Mirror command of WeavePoint 4.

Fig. 2.4
Invert- This will create the opposite of the present state. Whatever squares are black will become white and vice-versa.
Flip Horizontal or Vertical - this will create a repeat in the mirror image of the selected area, either side-to-side or upside-down.
To rotate 90 degrees, check Rotate.
In addition, you can select various effects in combination.
To rotate 180 degrees, check Rotate, Flip Horizontal, and Flip Vertical.
Note that rotating 90 degrees is applied to a square grid, check Flip Horizontal and Flip Vertical.
Transparent - is for pasting in liftplan, tie-up, treadling, and also in design mode.
For other Tie-Up Special Effect, see also Utilities/Tie-Up Special.
The main difference between Paste Special in the Tie-up and Tie-up Special from Utilities Menu is that in Paste Special you can
manipulate a section of your Tie-up, while in Tie-up Special you can only make changes to the entire Tie-up grid.

Paste Special – Liftplan
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Fig. 2.5

When using Paste Special in a liftplan, you can apply the following features: Invert, Flip horizontal, Flip vertical, Rotate, and
Transparent; as well as Insert and Color specification.

Paste Special – Treadling

Fig. 2.6

When using Paste Special in the Treadling area, your options are Color, Number of Copies and whether to Advance, as well as Insert,
Flip horizontal, Flip vertical.
In Treadling, you can displace the pasting position by changing the Advance value. This way you can quickly construct an advancing
twill or make other effects. A positive value will advance each copy by the number of steps according to the value; a negative value will
descend each copy. Leave the value at zero for no effect.
Paste Special – Threading
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Fig. 2.7
In addition to Insert, Flip Horizontal, Flip Vertical, this dialog box offers Advance features.
In Threading, you can displace the pasting position by changing the Advance value. This way you can quickly construct an advancing
twill or make other effects. A positive value will advance each copy by the number of steps according to the value; a negative value will
descend each copy. Leave the value at zero for no effect.
Using Edit/Paste Special to Insert
1.)

Select an area the size you want to insert.

2.)

Choose Edit/Copy

3.)

Select the starting end/pick where you want to do the insertion.

4.)

Choose Edit/Paste Special and check Insert in the dialogue box.

5.)

Now you can edit the inserted ends/picks as you like. This is a great method to do limited repeats.

See also Copy and Paste.

How to Quickly Make a Specific Twill in the Liftplan Using Paste Special
1.)

Draw the first twill line in pick one of your liftplan.

2.)

Click the Selection tool speed button

3.)

Select the first line in the liftplan. It becomes gray as you select it.

4.)

Choose Edit/Copy.

5.)

In the liftplan, select Shaft 2 (second vertical line).
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6.)
twill.

Choose Edit/Paste Special. In the dialogue, check Fill Remaining to fill the liftplan. Then click Apply and there’s your

Fig. 2.8
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How to Create Advanced Threading
1.)

In your threading, create the initial pattern you want to advance, Select it, and Copy.

2.)
Using the Selection Tool, mark the end where you want your advanced part to begin. The size of that selection is not
important, just the starting position. It is enough to mark just one thread.

Fig. 2.9
3.)
Go to Edit Menu, click on Paste Special. Paste Special-Threading window comes up to enter the option of how many copies
you want and the Advance step. Choose your options and click OK. You can always use the Preview button to be sure it is the way
you want, before using the OK button. Corrections can be made by using the Cancel button and trying again.

Fig. 2.10
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4.)
Your threading is advanced by the desired advanced step from your chosen initial. The same procedure can be used for
Treadling.

Edit/Modify
This dialog box will enable you to quickly Invert, Flip, Rotate or Wrap a part of your draft. Simply use the Selection Tool
and then open this dialog box from the Edit menu to change the area you have pre-selected:
Invert: Invert the selection (negative/change face).
Flip Horizontal/Vertical: Flip the selection.
Rotate 180°: Rotate the selection 180 degrees. Equals Flip Horizontal + Flip Vertical.
Rotate 90°: Rotate the selection 90 degrees. The direction of rotation will depend on your layout settings in Options. To
rotate 90 degrees in the opposite direction, click three times. Note that this rotation will be applied to a square grid, even if
your selection is a rectangle, so for rotation 90° it is recommended to select an area of equal width and height.
Arrow buttons: Cycle (wrap/shift) the selection in any of four directions.

Edit/Delete
If a selection has been made, the selected area will be deleted or cleared.
In threading, treadling, and color grids, the selected end/picks or colors will be deleted. In tie-up and design grid, the selected area
will be cleared.
In the liftplan, delete works in a special way. If the selection spans the entire width of the liftplan, the selected picks will be deleted.
If not, the selected parts of the liftplan will be cleared (shortcut: press the Delete key).
If no selection is made, the end or pick under the cursor will be deleted.
Edit/Crop
Crop to selection. This function is especially useful in Design Mode. If you only want to use a part of your design and cut away the
rest, select the area you want to keep and click Edit/Crop. The selected area will be moved to the starting corner (position 1,1) in
the Design Grid.
This function can also be used in the Threading, Treadling, Liftplan, and Tie-up grids.
Edit/Select and Copy
You can select and copy an area with Select and Copy. This method is especially useful if you want to copy an area larger than visible
on the screen. Select and Copy works the same selecting an area with the Selection tool and choosing Edit/Copy. Simply choose the
area you wish to select (Threading, Lift, Warp or Weft colors) and then the number, say from 5 to 20. The Selection size will be
displayed in the Status Line at bottom left.
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Fig. 2.11

Edit/Unlink Colors
Determines if colors are linked when inserting or deleting ends and picks. Also determines if the colors will be expanded with the
pattern when using Translate.

Edit/Copy Image
Copy the complete present weaving image to the clipboard. You can then paste it as a graphic in a paint program, text editor, etc. You
can reduce the size of the image by reducing the size of the WeavePoint window before selecting this command.
Note: For capturing the complete WeavePoint window with title bar, tool bar, status bar, etc., press Alt-Print Screen (a standard
Windows feature).
Please note, in both cases, the software saves the images as a .BMP file.

Edit/Clear
Clear entries in an entire, specified grid area. Select All to clear all grids.

Edit/Numeric Input
To input your Threading or Treadling numerically, select Numerical Input from the Edit Menu. A window will appear in which you
will be able to type in your sequence for either threading or treadling.
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Fig. 2.12
Write the shaft number for each end (or treadle number for each pick) with a comma or space between each number.
You can also create a sequence, like 1-8 means input end 1 on shaft 1, end 2 on shaft 2, end 3 on shaft 3, etc., until 8. You can write
many sequences in combination, like 1-8-2-7, etc.
To input multiple sequences, use parentheses For example, for 3 times 1-16 sequence enter 3(1-16).
Click Input or press Enter to make the input.
Edit/Keyboard Input
You can use your keyboard for entering in all three draft grids, depending on the Loom Type selected in the Options Menu.

Some find this easier than using the mouse, and it is also useful if using a laptop PC without a mouse.
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Fig. 2.13
When you select Keyboard Input from the Edit Menu, a dialog window will appear with the information specifying which grid you are
entering and also the position of your cursor. During the entering process, the window will remain open and will update the cursor
position.
Along with this window, a cursor (“+”) will appear in the end/shaft or pick/treadle indicated in the window.

Fig. 2.14
Move the cursor with the arrow keys, and mark the end/shaft or pick/treadle at the cursor by pressing the space bar or the '+' key. When you mark
an end/pick, the cursor automatically advances to the next end/pick in threading and treadling.
Hold the given key down for repeating entries, to move the cursor fast.
Press the Home and End keys to move the cursor quickly to the start (►) or end (◄) of the grid.
Press PageUp (▲)and PageDown (▼) keys to scroll the pattern.
Press the Insert and Delete keys to insert or delete an end or pick.
To delete a mark, position the cursor on the filled square and press the space bar. If you wish to make a change or correction, and the position is
already marked, the first mark will be cleared as the new one is entered .

2-13

In Keyboard Input you can also press the number keys for the shafts or treadles you want to mark. If the cursor is at end one, press '1', and end one
will be marked at shaft one. The cursor will advance automatically to the next end/pick. Then press '4' to mark end two at shaft 4, etc.(Note: you
must use the number keys above the letters on the keyboard, the numeric keypad at the right side of the keyboard does not work for this). To enter
shafts 11-24, press the keys QWERTY (Q = 11, W = 12, etc.).
You can access Keyboard Input directly by pressing the function keys F2, F3 and F4, and you can exit from Keyboard Input by pressing the Esc key.
This way you can keep the use of the mouse to a minimum.
The present cursor position for Keyboard Input is displayed in the small dialog window. Click the Close button or press Esc to exit from Keyboard
Input.
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VIEW MENU
There are two parts of View Menu. The top part options (Draft, Design, Fabric, and Interlacement) show all the
different modes you can be in within your main window. The Bullet next to the view option shows the current view.

View Menu
The first four items on the menu will display different visuals of the design which is currently open. The last two items (Show
Threading and Fabric Window) are options are for viewing your draft with or without the threading and for displaying a
window showing the fabric in its current design status, simultaneously with the views in the top portion of the Menu. The
check mark beside these options is a toggle for display (with check mark) or hiding (without checkmark).
View/Draft

Fig. 3.1

Draft Mode is the standard mode to draw and edit weaving patterns, allowing you to make choices in the Threading, Liftplan
or Tie-up/Treadling, and Drawdown areas. Note that you must enter a Threading and Liftplan or Tie-up/Treadling in order
to show the fabric structure in the Drawdown and allow for this option of editing your fabric design.
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How to Edit the Drawdown/Fabric in the Draft view: In Draft Mode, you can edit directly in the drawdown area
simply by clicking in a square. Left click to fill in; right click to erase.
Editing the Drawdown in Liftplan Mode: Changes you make in the drawdown will be reflected only in the line/bar of
the Liftplan that directly affects that particular weft. The Threading will not be affected by changes in the Drawdown or
Liftplan.
Editing the Drawdown in Tie-Up Mode: Changes you make in the Drawdown will be reflected in the Tie-up and will,
therefore, affect all other picks based on the same lift combination. The Threading will not be affected by changes in the
Drawdown or Tie-up/Treadling.
View/Design
In Design Mode, you can create the look of the fabric, drawing the pattern directly “from the fabric”, or creating a design in
freehand. It will appear as in a Drawdown, without the Threading or Treadling/Liftplan. To turn your pattern into a draft for
weaving, just select View/Draft and the draft (Threading, Treadling, and Tie-Up or liftplan) will automatically be
constructed, automatically opening into the Draft View.

Fig. 3.2

You can also use Design Mode to design patterns in other textile mediums; that is, patterns for knitting, embroidery, or
anything else that can be designed with the use of pixels. It works much like a specialized paint program, using pixels.
You can move between Draft Mode and Design Mode while making a pattern. Be aware that some changes to your pattern
can take place. For this reason, the program will ask you to Save your pattern to a new file before changing mode. If you have
a pattern with repeats in Draft Mode and change to Design Mode, the pattern will automatically be reduced to one repeat.
This is done to make it simple to make some changes and then repeat it. When you want to fill the pattern with the repeat,
use the Repeat and Fill tools. If you return to the Draft View without filling out the pattern, Draft View will open showing
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the single repeat, as reflected in the Design View. This is why you are instructed to Save your original draft prior to exiting
Draft for the Design View.
Design Mode uses a 2400 x 2400 grid. This means it can accommodate up to 2400 ends and picks. If you convert a pattern,
from Draft to Design, with a repeat larger than 2400, your pattern will be cut off when you enter Design Mode.
If you draw a large pattern in Design Mode, it could be cut off if you change to the Draft Window in Tie-up/Treadling Mode.
The pattern will be limited to 128 shafts and 128 treadles. This means that your pattern cannot contain more than 128
different picks. To be sure not to exceed this limit, you can keep the repeat within 128 columns in the Design window (or
within as many columns, up to 128, depending on number of harnesses you intend to use). There is no limit if you use
Liftplan Mode.
As long as you stay in Design Mode, including saving and opening Design Mode patterns, no such limitations can take place.
When saving in Design Mode, the pattern is stored as a standard .WPO file with liftplan. If the pattern uses more than 128
shafts, a special file will be saved in addition to the .WPO file (to preserve the full pattern). This file will have the same name
as the WPO file, but will have the extension *.wpb. The saving and loading of .WPB files is automatic. Note that the .WPB
files will carry the same names as the related .WPO pattern file. Patterns will not be saved as .bmp, in WeavePoint. In order
to save as a .bmp, select and copy an area from any grid and paste it into a graphics program as a new image; Save the image
as a .bmp file.
All Tools will have the same function in Design View as in Draft View. When using the Selection Tool in Design Mode, the
selected area will be darkened to more easily see the selection (the darkest colors will be affected to enhance their viewing
while selected).
View/Fabric

Fig. 3.3

Displays the pattern as a flat surface. The Fabric View can be zoomed just like the Draft. This view of the fabric will respond
to changes made in the Fabric Options Dialog Box. See Below for further information.
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View/Interlacement

Fig. 3.4

Displays the drawdown as a three-dimensional structure to better visualize the interlacement of the threads.
White threads will be displayed as light gray, to make them visible against a white background.

View/Fabric Options
Selecting this item on the Menu will open the Fabric Options dialog box. Using these tools you can enhance the
Fabric View to more closely resemble your final fabric, creating a fabric simulation.
Select an appropriate Fabric View mode. The fabric view can be zoomed larger and smaller just like the draft. The
relative size of warp/weft yarn is displayed according to your settings in Fabric Options and in the Yarn Density
settings in the Yarn Info Dialog. (See Chapter 8, Yarn Info).
Zoom in fabric view is not the same for all fabrics, but relative for each fabric. This is to ensure that zoom level
one can display details in the fabric. When you change yarn data, the size of the fabric displayed at the present
zoom may change.
The simplest and quickest way to set up a fabric simulation is to enter the desired density (EPI or ends/cm and PPI
or picks/cm) and select a fabric mode in Fabric Options.
All fabric simulation modes support combining thick and thin yarns, when you select Use Density from Yarn
Info. Yarn size that is smaller than its space, allowing some room between threads, is supported in Auto and
Balanced mode.
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Fig. 3.5

Auto/Yarn Data
In Auto mode, the program will determine from the yarn data whether or not the weave is balanced. If no special
yarn density is set, Auto mode will give the same result as Balanced.
You can let the program decide the packing of threads based on your individual yarn settings in the Yarn Info. If
you set the space for a yarn smaller than its diameter, the yarn will alternate with a neighboring thread and also
share its space in order to be visible. One benefit of Auto mode is that it will work for various sections of the
fabric, and it also can be combined with depicting space between threads. To make two specific yarns pack
together, set the space for both to half of the diameter (or set the diameter to double the space). If you want to
show some space around the threads, you can set the space to maximum 2/3 of the diameter (or set the diameter to
minimum 150% of the space).
Balanced
Select Balanced for balanced weaves like plain weave, twill and satin.
Warp/Weft faced
For weaves that are warp or weft dominant or have more than one warp or weft, like rep, taqueté, samitum, select
warp faced or weft faced.
Double weave
In double weave simulation, the layers should be ABAB or ABBA. The sequence AABB will not work, you can
change it to ABBA by deleting the first thread. This simulation works best when both layers are 1:1.
Use Density from Yarn Info
Set up thick and thin threads for a rep weave, for diversified plain weave or other weaves, in the Yarn Dialog.
Check the Use Density from Yarn Info box in Fabric Options, to use the individual yarn settings instead of the
general density setting in Fabric Options. The size and spacing depends on the yarn, the sett and type of weave.
Suggestion: Wind an inch/cm on a ruler to help decide the yarn size/grist to enter.
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Start Simulation on Even Pick/End
This will give a slightly alternative fabric simulation for some weaves and is an option to consider in your View.
Outline Threads
This selection will enable easier viewing of the individual yarns with in the textile structure.
Background Color
Click the color square to bring up the Color dialogue to change the background color behind Fabric View.
Information for a Supplementary yarn
For weaves that use supplementary yarn, check a yarn as supplementary in the Yarn Dialog. A supplementary
thread is a thread that floats over and underground threads, it does not have a space of its own and does not add to
the width or length of the cloth. To enable the Supplementary Yarn function, select Auto mode. Set the density for
the ground weave in Fabric Options and the supplementary threads will float over and under the ground weave.
You can use a supplementary yarn in parts of the fabric, as opposed to selecting warp faced or weft faced which
works best for fabrics that are uniform throughout.
Open-spaced or transparent fabrics
To create space between the threads, to simulate a fabric with an open or transparent weave, check Use Density
from Yarn Info and select Auto or Balanced fabric mode. Next select size and spacing for each yarn in use in the
Yarn Dialog. To show space between the threads, set the yarn space a little wider than the yarn diameter. You can
also change the background color, which will show through the fabric.
Limitations of Fabric Simulation
The simulation of packing of threads in a fabric is limited to two warp and/or weft threads packing into one. The
thread on which the warp or weft sequence starts can sometimes influence the simulation of warp faced, weft
faced and double weaves. The starting thread may also influence the simulation when scrolling the fabric. Add or
delete an end or a pick at the start of the pattern, to change the result. If one warp or weft forms the main pattern,
this should be placed on even numbered picks. Using Supplementary Yarn will avoid this issue.
When threads are packed, floats may appear to be longer than they really are if the packed threads are the same
color. To improve the visual result, enter yarns with slightly different colors.
How to use Yarns and Fabric View
In addition to designating the EPI and PPI (or ends/cm) and picks/cm) in Fabric Density in the Fabric Options,
you can enter a value for the yarn size/grist/diameter and the spacing for each yarn used in the Yarn Dialog. If the
yarn size and the spacing are the same, let the Yarn Space = Yarn Diameter box be checked, and enter the yarn
size only. If you do not enter a value for yarn size or spacing, the density designated in Fabric Options will be
used for the yarn. Note that to enable the individual yarn settings, select Use Density from Yarn Info in Fabric
Options.
To find the yarn diameters/inch or diameters/cm, you can wind an inch or cm on a ruler to help decide the size to
use. You will then find the wraps/inch (WPI) or diameters/cm. Depending on the weave, yarns/inch can be the
same number or a different number. Yarns/inch should be entered for the finished cloth, rather than the values
(sett) on the loom. If you do not want to see any space between threads, set the size to the same as the spacing.
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Although a yarn has a specific size/diameter, it may be woven with different spacing in warp and weft in a fabric.
If you use the same yarn for warp and weft with different spacing, enter the same yarn/color twice, assigning each
a different number in the Color Index. The same yarn at different spacing, tighter or looser, can appear very
different. Define the size and spacing of each one to have them display different attributes.
If two different yarns with the same size are used in the warp or weft, and a single weft or warp density is desired,
enter a single value of the total density for each yarn. For example, your desired weft density is 20 PPI or
yarns/cm; enter 20 for each yarn, not 10 for one and 10 for the other.
For yarns with different sizes, imagine yarns/inch or yarns/cm like the EPI (or ends/cm) or PPI (or picks/cm) for
the yarns as if there were only one yarn in warp or weft. Or imagine the yarn wound on a ruler and think wraps
per inch or cm. The yarn count number (like 10/2 cotton) is another expression of the thickness of the yarn. Look
at the yarn diameter and space in the yarn dialog to better understand how it works. Even if you enter
diameters/unit and yarns/unit, the resulting diameter and space are the actual size values. Note that to set a
diameter or space larger, you enter a smaller value (lower number). The less wraps or threads per unit, the thicker
the yarn.
In Print/Fabric, one option is to print the fabric to actual size. To enable this, enter the yarn settings appropriately.
If using the density settings in Fabric Options, set EPI (or ends/cm) and PPI (or picks/cm). If your sett is 25 ends
per inch or cm, this will be the scale on the printout. If using variable yarn settings, note that it is the space setting
for a yarn that determines the size of a cloth, not the diameter (if different).
If you are not using variable yarn size or space, use the fabric density setting in Fabric Options. You don't need to
fill in either size or spacing for the yarns.
Check out the newest sample patterns to better understand yarn settings.

View/ Show Threading
Choose View/Show Threading or click the corresponding speed button in the Tool Bar to hide/show the
Threading and Warp Color Grids in Draft Mode.
Hiding the warp grids makes room for displaying more of the pattern and treadling/liftplan when editing in the
weft grids or the drawdown.

View/Fabric Window
Show/Hide the Fabric Window. This is a separate window that floats on top of the main window. It shows a
representation of the fabric directly out of the Draft window, without the Threading or Liftplan/Treadling grids.
While editing, you can see your changes in the Fabric Window. It will display your pattern at the smallest size
possible (1 screen pixel per end/pick) to enable viewing a larger portion of the fabric.
Click a specific area in the Fabric Window and the corresponding location will be shown in the Draft window.
The end and pick you click on in the Fabric Window will then appear in the middle of the Draft Window. This is
an effective way to move around in the pattern when working with a large pattern.
You can resize the Fabric Window as you like. This View is not based on the attributes that you have set in the
Yarn Info dialog and/or Fabric Options. It is simply information associated with the Draft View.

Please refer to Chapter 8, on the Yarn Menu, for further information on the Fabric Simulation feature.
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UTILITIES MENU
Please note that Preview and Cancel options are available in most of these dialog boxes.

Tie-up Mode

Liftplan Mode

Utilities/Tromp as Writ
This function is also called “As drawn in”. In Tie-Up Mode, select to copy threading to treadling or vice versa, or
warp colors to weft colors or vice versa. In Liftplan Mode, you can only select to copy warp colors to weft colors
or weft colors to warp colors.

Fig. 4.1

If you are threading, and able to treadle the harnesses or use the electronic assist on your loom, you can use
Tromp As Writ to lift the harnesses to present in the correct order for threading. Save your Draft as a new file,
especially for this purpose, perhaps with an indication in the name that it is for threading use only. In the new
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file, switch to Treadling/Tie-up mode. Enter a single diagonal line in the Tie-up grid and then use this Dialog
Box to copy the Threading to the Treadling. In Weave mode you will automatically be switched back to Liftplan,
for the actual weaving process.

Utilities/Make Symmetrical/Warp or Weft
Select this option to quickly make the warp or weft symmetrical. The warp or weft will be mirrored from the last
end/pick filled in. Note that you can also mirror (flip) parts of a pattern with Paste Special. See also Copy and
Paste. Ensure that there are enough ends/picks in your draft to accommodate the increased number of ends/picks
this action will entail.

Utilities/Insert and Delete
Inserting and deleting ends and picks can be done in a variety of ways. You can insert and delete both in Draft
Mode and in Design Mode.
Using Insert and Delete Keys
To quickly insert and delete ends or picks one by one in Draft Mode, place the mouse cursor on the desired end or
pick in the threading or liftplan/treadling, then press the Insert or Delete key. Insert will open up the draft.
Delete will remove a thread or pick. You can insert and delete colors in the same way.
Note: Do not press any mouse button. To make it easy to place the cursor accurately at an end or pick, use a
higher zoom level.
Using Insert/Delete Dialogues
Choose Utilities/Insert or Utilities/Delete to reveal a dialogue box. Pick the first number and last number of the
sequence and hit OK.

Fig. 4.2
Insert/Delete Ends
Select the end to insert from and number of ends to insert or delete..
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Insert/Delete Picks
Select the pick to insert from and number of picks to insert or delete..
Insert/Delete Shafts
Select the shaft to insert from and number of shafts to insert or delete.
Insert/Delete Treadles
Select the treadle to insert from and number of treadles to insert (available only in Tie-Up Mode).
Deleting shafts or treadles is a quick way to delete, for example, a tabby inserted in the treading or treadling.
You can also use Cut or Delete from the Edit Menu, after a selection has been made, using the Selection Tool.
Change Face
Selecting this choice will immediately flip the Threading horizontally and reverses the Tie-up or Liftplan, and the
opposite face of the fabric will show in either the Draft, Fabric View, or Interlacement. This will turn the
horizontal direction of the fabric design, as if you were turning the fabric over, like a page in a book. Click this
selection in the menu again to reset to the original face. There is also a Change Face speed button on the Tool
Bar.
If you do not wish to reverse the threading, use Reverse Liftplan/Tie-up instead.
Reverse Liftplan/Tie-up
Selecting this option will reverse the full Liftplan or Tie-up, rising the opposite shafts instead. This will enable
you to view the opposite face without changing the direction of the pattern, but it will affect the action of the
loom, if left in place, causing the opposite movement in the shafts/harnesses.
Utilities /Tie-Up Special
These tools provide another way to generate twills when in Tie-up/Treadling Mode, by making simple changes to
the Tieup from this dialog box.

Fig. 4.3
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Make Twill from Shaft 1
Before using this option, mark Shaft 1/Treadle1 in the Tie-up.
Make Twill from Shaft 1 and Treadle 1
Before using this option, the shaft 1 line and treadle sequence must be filled in.
How to Quickly Make a Twill in the Tie-Up
1.)
Mark first square in the tie-up.
2.)
Choose Utilities/Tie-Up Special. In the dialogue, select Make Twill from shaft 1. Then click OK and
there it is.
Horizontal/Vertical/Rotate
Use these options to change the axis of the Tie-up.

Utilities/Wrap Liftplan
This submenu is only displayed if you are in a liftplan mode. Move the entire liftplan to one side. The part that is
pushed outside the liftplan will wrap around and appear at the opposite side.
You can wrap the liftplan to alter the pattern. For example, it is useful with many networked patterns.
You can wrap a selected part of the liftplan, if a selection has been made (see Selection Tool).

Fig. 4.4

Utilities/Flip Liftplan
This tool will flip the liftplan horizontally, changing the dynamic between the liftplan and the threading, to give a
different effect in the textile. Select this in the menu again to reverse the action.

Utilities/Switch Shafts
Use this command to rearrange the shafts. When shafts are switched, the corresponding liftplan or tie-up area will
also move and your drawdown pattern will not change.
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Hint: Sometimes it will be easier to rearrange shafts if you increase the number of shafts to one more than
actually needed. You will then get an empty shaft to switch to, which eliminates the need to swap with an already
used shaft.

Utilities/Switch Treadles
Use this command to rearrange the treadles. When treadles are switched, the corresponding tie-up area will also
move so that your drawdown pattern will not change (see also Switch Shafts).

Utilities/Reverse Warp Order
Reverse the order of the ends so that the first end becomes the last end and vice versa. If you want to see the true
reverse side of the cloth, use Reverse Tie-Up/Liftplan and Reverse Warp Order to mirror it.
This command can also be useful if changing a display style between left and right start positions in the threading.

Utilities/Reverse Weft Order
Reverse the order of picks, so that the first pick becomes the last pick and vice versa.
This command can be especially useful when changing display style between top and bottom start position in
treadling/liftplan (see Options).

Utilities/Reduce to One Repeat
Use this to reduce the pattern to one repeat. You can use this to "undo" repeats made by Repeat with Fill Pattern.
The threading and liftplan (or treadling in Tie-Up Mode) will be reduced to one repeat, if a repeat is found. Warp
and weft colors will not change.
Before the reduction takes place, you will be asked if you want to use the color repeat. If the warp colors repeat is
longer than the threading repeat or the weft colors repeat is longer than the liftplan/treadling repeat, the result
depends on your answer. If Yes, the color repeat will be used. If No, the color repeat will be ignored. Note that
in both cases, the color grids will remain unchanged. To not reduce the pattern, click Cancel.
Patterns with Borders
If you have borders in your pattern, you cannot reduce the pattern to one repeat. Because the border is not
repeated, the whole pattern will look like one repeat to the program and a "No repeat found" message will be
displayed.
If you use borders, it is natural to include the borders and have the total fabric in one pattern file. This is useful
for things like displaying and printing the fabric and for Analyze Menu functions. But when working with a
pattern with borders, it is a bit more laborious to make changes to the pattern and then have the changes repeated.
Sometimes it would probably be easier to work with the pattern without the borders and have the borders in a
separate file. You could then copy and insert the borders at a later stage of the pattern development.
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TRANSFORM MENU
Transform Menu has all the most complex features of WeavePoint. All feature are wonderful tools for helping you design unique
textiles. Please note that all dialog boxes in the Transform Menu have a Preview and Cancel option.

Transform Menu/Tie-up

Transform Menu/Liftplan

Transform/Block Substitution
Working with Profile Drafts
One method of developing a pattern starts with a Profile Draft. Each square in the Profile Draft will represent a complete group of
ends and picks in the final draft. So, in this design process the pattern of the Profile will be expanded accordingly. A Profile Draft is a
design tool and is not intended to be woven, but used in combination with other design tools on the Transform Menu.
A Profile Draft can be used in various ways and can be woven with many different weave structures. Use the normal draft view or
design view, in tie-up or liftplan mode. You can enter a liftplan or tie-up/treadling, as well as threading. In a Profile Draft Block one
(A) will be represented by shaft one, block two (B) will be shaft two, etc. A Profile Block in a Profile Draft is a linier unit.
You make a Profile Draft just like you make a normal repeat for a pattern, except you know you will use this one as a Profile. Be sure
to use “Profile” in the name when you save these drafts. A tip is to save your Profile Drafts in a separate folder and Block Patterns (used
with the Block Substitution command) or Translation Grids (used with the Translate and Overlay commands) in separate folders to
more easily locate them.
There are three ways to transform your Profile Draft into a full pattern with block weaves. The three tools are found in the
Transform Menu.
1.)
Block Substitution: Use this traditional method to replace each Profile Block in the threading with Block files. This will
expand the size of the pattern exponentially, depending on the number of Blocks and ends/picks contained in each Block in the selected
file.
2.)
Translate: Using this tool, the concept of Block Substitution is made easier and affects the Threading, as well as Treadling or
Liftplan. Select weaves from a pre-defined Library or enter your own weaves. This will expand the size of the pattern exponentially,
depending on the number of ends/picks represented by each block.
3.)
Overlay: Overlay within the confines of the liftplan. This is also know as “interleave” and resembles overlaying weaves for
jacquard patterns. Unlike Block Substitution and Translate, this will not expand the pattern, so the pattern must have the correct
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number of ends and picks before the overlay. It is very useful for overlaying weaves on networked liftplans and for some weaves, such
as shadow weaves.
Creating a Profile Draft
A Profile Draft can be used in various ways and can be woven with many different weave structures. A tip is to save your Profile Drafts
in a separate folder, to be used with the Block Substitution, Translate and Overlay tools.
Enter a Profile Draft just like you would make a normal pattern, except you know you will use this one as a Profile. Block one (A) =
shaft one, block two (B) = shaft two, etc. You can also enter your Liftplan or Tie-up/Treadling .

Fig. 5.1 - Profile Draft –showing a four block profile
Note that, in a Profile Draft, all of the warp is one color (red) and all of the weft is a second color (white). This contrast
will be used during the Transform functions.
Save it to a special Profile folder.
Creating a Blocks Draft
During Block Substitution, the weave structure of each Block will be, literally, substituted for each square in the Profile
Draft. Enter blocks in a normal threading (and treadling) grid, just like you would draw a normal pattern, except you
know you will use these Blocks to fill your Profile.
Unlike the Profile Blocks, these Blocks are made up of the threading sequences, which are then defined by the break in
the color assignments. Start drawing Block one (A) from end one, and then continue with Block two, etc., until you have
drawn all the blocks you need. Leave no blank ends (unless you want a block to contain empty ends).
In this example, four Blocks of 4 ends each are shown, differentiated by the assignment of four different colors, one to
each Block. If you have three Blocks of eight ends each, they will all together occupy the first twenty-four ends in the
threading grid and you will need to assign a different color to each of the three Blocks.
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This applies to the Liftplan or Tie-up, as well.

Fig. 5.2 - Creating a Four Block Profile
The tie-up in the Blocks file will automatically be used in the resulting expanded pattern, if both the Blocks file and the
Profile are tie-up files. The draft type for Profile and Blocks must match. If you are working in Liftplan, any tie-up in the
profile pattern will be dropped.
Save to a special Blocks folder, with a name to remember it contains blocks, like “4Blocks4Ends_1”.Once you have made
and saved a blocks file, you can reuse it any time you want for building new patterns.

Block Substitution
Open your Profile Draft and select Transform\Block Substitution to expand the Profile Draft. The dialog box that appears
will lead you to select the desired Block file. In the same window, you will be selecting if you want the Blocks to be
placed at an Absolute Position - on the same shafts as drawn, or if you want each Block to be placed Relative, to new
shafts - in effect expanding the number of shafts.

Fig. 5.3
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If the Profile Draft includes treadling or liftplan information, and the Block file to be introduced has the same format and
treadling/liftplan entries, that information will also be transformed as well.

Transform/Translate
This command is used to quickly translate a Profile Draft into a full weaving draft. The Translate command works in a
new and different way from Block Substitution. Here, each square in the Threading and Lift plan will be replaced by
specific Block Units, selected from a Library of weaves or created by your self. Only two weave units will be entered
regardless of how many Blocks the Profile Draft may contain. One Unit will be imposed on the black squares of the grids
and the other in the white squares.
First, make a Profile Draft, as described above. Use Normal Edit Mode or Pattern Mode, Tie-Up or Liftplan Mode.
For this example we will be working with the 4Block4Ends Profile Draft, shown in Fig. 5.2.

Fig. 5.4a – Preview of Tie-up file with Translate tool
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Fig. 5.4b – Preview of Liftplan file with Translate tool

In our example Translate window, the small black box at the far left indicated that the 4x4 grid on the right will be applied
to the dark squares of our Profile Draft, and the 4x4 grid on the left will be applied to the white squares.
Then you need to decide which weave units to use. There are three ways to do this: select from the Weave Library, load
units from another file, or make new units.
Weave Library
The Weave Unit Library contains many weaves often used and is accessed when you choose Translate/Transform. The
Transform dialog box opens and allows you to select or create the weave units. When selecting a weave from the Library,
the units will be displayed as opposites. You can also edit these units if you like, but the changes you make will not be
stored in the generally accessed Library.
To save new or altered units, save the pattern as normal. The present units will always be saved with the pattern. Save
with a descriptive name like "My Twill Units" to remember that the file contains special units.
Load Units from File
Select your pattern. The weave units from the Library (see above) will be loaded. Note that the present units will be
saved along with the rest of the pattern whenever you save. This way you can save weave units you draw and load them
as needed.
Drawing Your Own Weave Units
The challenge here is to determine the size and contents of the two weave units for the target weave structure. To do this,
you can study the weave structure (interlacement) in question and find the smallest reducible weave units (or you could
call it interlacement repeats or key units). One unit is needed for the pattern area and the other for the background area of
the profile. Care must be taken here, or your Profile Draft might be expanded to astonishing proportions!
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Unit Size
Set the Unit Size for drawing your own units. The minimum setting is 1high and 2 deep. It is not necessary to set width
and height when selecting from the Library.
Clear
Clear the present units to begin drawing new units.
When translating, the colors used in the profile will expand like the pattern. You may find it best to wait until after
translating, to adjust the warp and weft colors.
Translation can be done both in Draft Mode and in Design Mode, but works in different ways: when in Draft Mode, each
square in the tie-up or liftplan will be replaced by the contents of the translation grids and the full length of the threading
(and treadling) will be expanded by the size of the units - a profile with five blocks (using five profile shafts) translated
with 4x4 weave units will make (5 x 4 =) 20 shafts. Preset the draft window to your loom specifications. (See Options
Menu).
In Design Mode, the pattern will be completely reanalyzed after translation and then automatically use a minimum
number of shafts which is useful for weaves such as summer and winter, overshot, and taquete. Note that you can equally
translate these weaves in Draft Mode and then choose Transform/Reanalyze to reduce shafts. After reanalysis, you can
rearrange shafts and treadles with Utilities/Switch Shafts and Switch Treadles if needed.
When, using Reanalyze (or when in Design Mode), the largest pattern that can be reanalyzed is 2400 x 2400 threads. If
repeats are found within this size, the pattern will automatically be repeated throughout the full length after translation.
This means that if the weave unit has a width of four, you can have a repeat up to 600 in the profile threading (600 x 4 =
2400) and get automatic repeat. The same applies in weft-direction. If your repeat exceeds this size limit, 2400
ends/picks will be translated and you will then need to adjust the pattern manually afterwards.
You can also use translation in two steps. For example, if you want to use a figure motif repeated on a background, you
can first make a profile of some stylized motif or image in the liftplan grid, with a simple threading. Now, use the result
as a new profile, fill in the weave structure units, for example, for Bronson Lace, and translate.

Fig. 5.5

Step 1 – Create the Profile Draft
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Fig. 5.6

Step 2 – Create the Unit Blocks and Translate!
For some weaves, you may not be able to obtain a perfect weaving draft by doing translation only. You can adjust the
pattern after translation, by adding or removing threads, or by altering the tie-up or liftplan.
You can also simply expand the profile draft without altering it, by using one completely filled (black) and one
completely empty (white) translation grid. The profile will then just be expanded by the size of the grids in each
direction. The Translate function can thus be used in various ways and when you understand how it works, you may
even find new ways to use it.
Construct Double Weave
To automatically construct a double weave, first, fill in the two layers as two single layers, one in each unit grid. For
example, use 4 x 4 grids to fill in a 3/1 twill and a corresponding 1/3 twill. Then click the Double Weave button. The
grids will expand to double size (in this example, to 8 x 8) with the two layers turned into double weave - one grid with
the first layer on top, the other grid with the second layer on top. You can then use the resulting double weave units to
translate a profile straight away into double weave. The initial weaves can use up to 8 x 8 grids (equals 16 x 16 when
doubled).
Again, we will start with our Flowers Profile Draft. To construct a double weave, follow these steps:
1.)

In the Transform window, use unit grids to create the face and the back of your fabric.
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Fig. 5.7

2.)

Click on Construct Double Weave. The window with layer position comes up. Make your selection. Click OK.

3.)
Units become constructed double weaves. The first unit (on the left) has the first layer on the top and the second
one (on the right) has the second layer on the top. At this point, you are ready to apply those double weave units into
double weave block interlacing designs.
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Fig. 5.8
Preview, if you wish, and select OK to make the change.

Transform /Overlay
Overlay is in many ways similar to Translate, and shares many of the same tools, but only affects the Liftplan and Design
Views. This tool cannot be used in Tie-up Mode. It will not affect the threading, only the liftplan. The weave units used
as in Translate are used here as well. Blend in two weaves over your present liftplan in one operation.
First, make your pattern with a “motif” or “profile” liftplan, complete with threading. It works best of one is developing a
design based on a larger scale motif with broad areas of pattern. Then select your weave units and click the Overlay
button. Keep in mind that the threading and number of ends in a unit will determine the effectiveness of the weave
structures you will impose.

Fig. 5.9

Profile for Overlay
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Fig. 5.10

After Overlay Command
Overlay offers four options for accessing units. You can use units from the Library, draw your own units, load units from
a pattern file, or use complete liftplans from two pattern files.
Many options in the Overlay window are the same as in the Translate window (see Translate for a description).

Transform /Network
Network drafting is a special technique for making larger, complex or curved motifs on a standard loom - without draw
devices or jacquard attachments. It originated in France and was brought to light by Masson/Roussel in their treatise Shaft
Weaving & Graph Design (1988). Teaching network drafting is beyond the scope of this manual - see magazine articles
or books about the subject, like Network Drafting - An Introduction (1994) by Alice Schlein.
Making a network pattern with paper and pencil is a tedious task. With the computer it is quickly done and this is
probably the main reason for the growing popularity of network drafting. The network function in WeavePoint lets you
network patterns in a quick and simple way.
In Tie-Up Mode, select to network the threading, treadling, or both. The present pattern line in threading/treadling will be
networked, based on which Initial is selected in the Network Dialog Box.
In Liftplan Mode, the present pattern line in threading will be networked, based on the selected Initial. If Ribbon Width is
higher than 0, the pattern line will be inserted in the liftplan as a ribbon with the selected width.
To paste in basic weaves or “key liftplans” over the resulting ribbon, use Overlay. To move the liftplan sideways, use
Wrap Liftplan (Utilities Menu).
The Pattern Line
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Use as many shafts on the screen for the pattern line as you want to use on the loom. The number of shafts on the screen
will not change when networking. If the upper shafts are left empty in the pattern line threading as extra room for the
network (also called using “shaft rule”), these will be filled in when networking. If all shafts are used, the network will
wrap around to the first shafts of the threading.
Telescoping
Telescoping, or telescopic reduction, is often used together with networking when creating a pattern line. Telescoping is
not a separate command, but a feature which can take place when changing the number of shafts (or treadles) in Options.
If you have a pattern with a threading and/or treadling using many shafts, you can reduce the amount of shafts/treadles
and still retain much of the pattern image and get other interesting effects. When selecting less shafts/treadles, the
threading (or treadling) will automatically be “compressed” or “folded” like a telescope. Telescoping works best with
pure “motif” patterns - like curved or pictorial drawings.
As networking involves options at various steps, it is a good idea to save the file anew at each different stage so that you
have the possibility to go back to the last stage. Note that you also can mix and match by saving and loading single
pattern elements, use Tromp as Writ, switch between Tie-Up and Liftplan Mode, etc.
To create a network drafted design, follow these steps:
1.)

Create desired curved shapes in your threading.

Fig. 5.11

2.)
3.)

Select Tromp as Writ from Threading to Treadling or draw other curved shapes in your Treadling.
Input some structure in your Tie-up.

Fig. 5.12
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4.)

Go to Transform, Network, and select a Network Initial from the offered library or from one of your own files.

Fig. 5.13
5.)

You have a network drafted design!

Expand
Enlarge the pattern by a selectable scale factor in warp and weft. This tool is typically used to enlarge a profile
draft or to multiply the lines in a liftplan.

Fig. 5.14
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Transform /Insert Threading
This is a powerful command for inserting a ground weave, like a tabby or twill, into a threading.

Fig. 5.15
Select one of the predefined threadings shown in the window or load a threading from another pattern. Check insert from
file and use the Browse button to locate the desired file. The selected file name will then appear in the long box. When
inserting a threading, the present threading will automatically be moved up to make room, if necessary, adding to the
number of shafts.
Interval
Select Insert From/After Interval and then select the desired interval between inserted ends. An interval of 1 will insert
an end after each present end; an interval of 2 will insert an end after every two present ends, etc. Tip: If you just want
empty spaces inserted, insert an empty threading.
Insert Color
Check this box and select the color from the drop-down menu. To later delete what you have inserted, use
Utilities/Delete Shafts. The drop-down menu to the right of the Color menu will allow you to select whether to Insert
Below, Above, or Overlap the existing threading.
Below means inserting the threading on new shafts below the present threading. This will increase the number of shafts
corresponding to your selected insert.
Above means inserting the threading on new shafts above the present threading. This will increase the number of shafts
corresponding to your selected insert.
Overlap means no new shafts will be added and the resulting number of shafts will be the same as before.
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Transform /Insert Treadling
Available when in Tie-up mode, this works like Insert Threading, above.

Transform/Insert Parallel
This menu item is available in Tie-up mode. Parallel Threading, a form of interleave, is used for shadow weave, warp
rep, echo weave, turned taqueté and more. The original threading is used for the first set of warp threads and is generally a
single color. A second set of warp threads, using the original threading sequence, is inserted alternating thread by thread
and is placed a consistent step above the original set. The two sets of threads follow the same sequence and are an equal
distance apart to create a parallel threading.
Select whether you wish to insert in Threading or Treadling, and whether to begin before or after the first end/pick.
If you wish to insert more than one Parallel Line, an additional box will appear, allowing you to place both lines in the
same action, by selecting the corresponding Line Number and Step.
If you wish to insert color with each parallel line, check the Insert Colors box and a Palette window will open, allowing
you to assign a color to each inserted Line.
Step can be set at 0, to simply double or triple the threading or treadling.

Fig. 5.16

Transform /Insert in Liftplan
Available when in Liftplan mode, use this to insert for example a tabby in the liftplan. Either insert picks from a liftplan
in a file or insert blank picks. To fill in the blank picks, remember you can draw one pick and use Copy/Paste Special to
repeat it.
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Fig. 5.17
Interval
Select the desired interval between inserting picks. An interval of 1 will insert a pick after each present pick; an interval
of 2 will insert a pick after every two present picks, etc.

Transform /Delete in Liftplan
To delete inserted picks, choose Delete in Liftplan.

Fig. 5.18

Delete picks in the liftplan at a selected interval. For example, an interval of 1 deletes every second pick; an interval of 2
deletes every third pick.

Transform /Re-Analyze Threading
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The threading will be entirely analyzed and reconstructed using as few shafts (harnesses) as possible. This command is useful to check if
a pattern can be woven with less shafts (and treadles). When in Tie-up mode, Threading and Treadling will be controlled through
separate menu selections (for Treadling, see below).
If the new arrangement of shafts is still not exactly like you want it, choose Utilities/Switch Shafts/Treadles to rearrange.
Up to 500 ends will be reanalyzed, but if a regular repeat is found within this limit, the pattern will automatically be corrected
throughout the entire width. If the pattern is wider than 500 ends and no regular repeat is found, the first 500 ends will be analyzed
and reconstructed.
Use Edit Menu/Undo to revert to your previous scheme.

Transform /Re-Analyze Treadling
The treadling and tie-up will be entirely analyzed and reconstructed, using as few Treadles as possible. This command is useful to check
if a pattern can be woven with fewer treadles. When in Tie-up mode, Threading and Treadling will be controlled through separate
menu commands.
This tool can only be accessed in Tie-up Mode, not in Liftplan.
The treadling/Tie-up will be adjusted so that tabby/twill is placed on the first shafts, as is customary. If the new arrangement of
treadles is still not exactly like you want it, choose Utilities/Switch Shafts/Treadles to rearrange.
Up to 500 picks will be reanalyzed, but if a regular repeat is found within this limit, the pattern will automatically be correct
throughout the entire height. If the pattern is longer than 500 picks, and no regular repeat is found, 500 picks will be analyzed and
reconstructed.
Use Edit Menu/Undo to revert to your previous scheme.

Menu Item/Straight Threading
This command lets you change a messy threading into a straight one, while keeping your pattern intact. Your pattern will be analyzed
and converted to straight threading, if possible. This selection will add considerably to the number of shafts required.
If the threading repeat is longer than the number of shafts you have available in the loom, you can not use a straight threading. Note
that maximum repeat for straight threading is limited to the maximum number of shafts, which is 128.

Menu Item/Turn Draft
This selection will swap warp and weft, in effect turning the pattern 90 degrees. All warp Threads will become the Weft Threads and
the Weft Threads will become the Warp Threads.
Edit Menu/Undo will allow you to revert to the previous warp/weft setting, if no other changes have been made subsequent to
selecting this menu item.
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FILL MENU
The fastest way to get a design up on the screen is to use the WeavePoint Fill Menu. It is designed as a separate menu
in the program and the menu options change according to the LOOM STYLE you have previously selected in the
OPTIONS MENU/OPTIONS DIALOG BOX/LOOM TAB.

Fill Menu/TREADLING

FILL MENU/LIFTPLAN

Fill/Threading

Fig. 6.1

Quickly fill the threading with a straight draw, pointed, or rosepath. The present number of shafts (or
treadles) will be filled in. If you already have a threading, it will be replaced.
Fill/Treadling

Fig. 6.2a

Quickly fill the treadling with a straight draw, pointed, or rosepath. The present number of treadles will be
filled in.
If you already have a treadling, it will be replaced.
Fill/Liftplan

Fig. 6.2b
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Three Selections are offered in this drop down menu: TWILL VARIATIONS, SATIN, or PLAIN WEAVE.
Fill/Tie-up

Fig. 6.3

The same Selections are offered in this drop down menu: TWILL VARIATIONS, SATIN, or PLAIN WEAVE.
Twill Variations
This selection opens the Twill Generator window. This tool will allow you to create twills on a random basis.
First, from the Fill Menu, select a Threading and a Treadling. Next, select Twill Variations from the Tie-up drop
menu. Now, select the Twill Direction, whether or not to have a Balanced Twill, and the Maximum Float
length desired. Click on the Generate Twill bar and the pattern displayed will be changed in the Tie-up or
Liftplan, as selected. The Threading (and Treadling) will not be affected.

Fig. 6.4
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The window will remain open as long as you continue to use the Generate Twill Bar. Cancel to return to your
original pattern. OK will close this window and your pattern will now reflect the change. Edit Menu/Undo will
reverse this, if no other subsequent changes are made to the draft.
The twills are created in a random manner, so, if you see a pattern you wish to keep, click OK and follow the Save
As procedure. Then, if you wish to revert to the original pattern, close without saving the changes and re-open.
This procedure will retain your original pattern and save your newly developed twill, tool.
Satin
The satin weave produces a smooth, lustrous cloth. The points or stitches should be scattered as widely and as
uniformly as possible. Use this satin dialog tool to understand and create satins. The satin weave requires at least
five shafts.
A satin is constructed by filling in one square for each pick, in the Tie-up Grid or the Liftplan. Starting with the first
pick and then proceeding to the next pick, the position will progress sideways by a selected number of ends. This
number is called a "move number" or "rising number". For each number of shafts, there are only a few possible
move numbers producing an even satin.
In the Satin dialog, the possible regular move numbers for the present number of shafts are displayed at the top of
the dialog box. The numbers are always listed in pairs. A move number in a pair will make a similar, but mirrored
satin weave of the corresponding move number.

Fig. 6.4
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Select the Move number and then take advantage of the Preview feature of this window, prior to selecting OK,
which will effect a change in your pattern. You can change the Move number, selecting Preview each time, prior to
making your decision and hitting the OK (or Cancel) button.
OK will close this window and your pattern will now reflect the change. Edit Menu/Undo will reverse this, if
no other subsequent changes are made to the draft, if you hit OK instead of Cancel. If you wish to keep the
Previewed Satin, click OK and follow the Save As procedure.
You can try out creating satins with different move numbers. You are also allowed to try move numbers that are
not listed as possible, in order to see the different irregular satins.
Plain Weave
Fill the present Tie-Up or liftplan with plain weave.
Fill/ Colors
Use this command to quickly select a predetermined pattern for your Warp Colors or Weft Colors. Your
selection will fill the entire Color Bar for Warp or Weft. Select Fill/Colors to open the Fill Colors dialog box.
A & B - Within the window are two complete color palettes, marked A and B. These are the standard 64-color
palette. Colors selected will be shown in the large box beneath the A/B Letters. See Chapter 11, on Working with
Color, for more information on the color selection/change process.

Fig. 6.5
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Fill – These selections give you a choice between eight predetermined patterns that will be repeated throughout
your warp or weft color bar. Select the colors to be used and which sequence to repeat. Then hit the Fill Warp or
Fill Weft button for the display to change in the Draft window. Your choice will not cause the dialog box to close.
If you wish to try a different selection, hit the Revert button to begin again, or Close when finished.
If you still change your mind, Edit/Undo will remove the changes. You can also use Edit/Clear/Colors.
You can use AB and AABB for color & weave effects. You can use AB for double weaves, shadow weave, taqueté,
and many others.
Note that this is just a quick way to select some common color schemes for the complete warp and weft. If this is
not suitable, paint the warp/weft yarns directly in the warp and weft colors grids. Then use the Repeat command
or Copy and Paste commands.
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ANALYZE MENU
Within this menu, you can analyze Repeats, Floats, Colors, and Heddles.

Each Report window has a File menu that allows you to print the window content, as well as an Edit menu that
will enable you to paste the content of each Report into a word document that can then contain all the information
from the four reports.
Analyze/Repeats
A report will be displayed showing the following repeats:
1.)
Warp: Threading, Warp Colors, and Total Repeat
2.)
Weft: Liftplan or Treadling, Weft Colors, and Total Repeat
Total Repeat has calculated the minimal repeat one has to select to get the design repeated completely according to
both the color and the structure. For example, if the liftplan repeat is eight and the color repeat is twelve, the total
repeat will be 24; for the repeat and the color sequence to coincide.
If no repeat length within 2400 is found, a length > (larger than) 2400 will be reported. A repeat is here defined as
the length of a pattern element that is starting from position 1 and is repeated regularly throughout the pattern. Note
that when a selvage is inserted at the beginning, there will no longer be a regular repeat to be found.
Analyze/Floats
A Floats Report will be displayed, showing an analysis of the full present pattern. The Floats window will remain
open and can be moved about the screen, enabling easier location and access to the specific floats for correctin. After
making a correction, you may click the Update button and the information in the window will be automatically
updated.
To examine the floats on the screen, select Thread Style in Options to better see the floats in the drawdown.
Analyze/Colors
The Color Report will be displayed showing the use of colors in warp and weft. It displays, in both number of ends
and picks, each color (referenced by its number) and the percentage of end/picks for which it is used.
Analyze/Heddles
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A Heddles Report will be displayed. The numbers shown are the exact number of heddles per harness used
throughout the full length of the threading.
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YARN MENU
This menu holds the tools for shaping your textile in the fabric simulation (See Chapter 3, View Menu)
and features tools for developing your own colors.

Yarn Info
Selecting Yarn Info will open the Yarn Dialog box.

Fig. 8.1
Here, in addition to color, you can enter a name, description, and a symbol for use in the threading and
treadling or liftplan for each yarn. The lower part of the dialog box has settings which will affect Fabric
View. You can select thick and thin yarns and more.
If you click in the rectangle to the right of the Yarn Palette drop down, the Color Dialog Box will open
and enable you to add/change colors directly into the Pallet from this location, for this specific file.
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Shortcut: Click G on the keyboard. If you don't change anything, you can close the dialog by pressing the
same key.
Click on the Help button to open the Help dialog box for immediate access to the Yarn Information
Symbols
Instead of the standard filled square, symbols can be used in threading and treadling or liftplan. The
symbols can also be used with Print Draft and Export Draft to PNG image. If you have selected “Yarn
Colors in Grids” in the Options Menu/Layout Tab, and select the circle symbols here, the circles will be
filled with the yarn colors.
Tools
In the Yarn Info dialog box, there is a Tools menu. In the Menu you can move all yarns in use in the
current draft to the top, and you can clear all yarns not used in the current draft, by simply making the
selection in the drop down menu. If you should have a change of heart, simply hit Cancel to reinstate the
original list. Numbers will remain, but colors will be removed from cleared yarns. Colors are considered
to be used only where the threading and treadling/liftplan are filled in.
You can also Import Yarns from other WeavePoint pattern files (.wpo files).

Fig. 8.2

Import Yarn
When Import Yarn is selected, an Import Yarn window will open, in which to search for and select from
among other WeavePoint pattern files (.wpo files). First, select a file and a new dialog box will open. In
the Import Yarn dialog, click in the first , long window with the down arrow and you will see all the yarns
in the import file by color and name. Select one of three ways to import yarn:
One by one: Select the yarn to import and the index location/number to import it to in your present
palette. Click Import. Repeat for each yarn to import. The index will automatically advance one step for
each import.
All named yarns: Imports all yarns in the import file that have a name. The yarns will be placed in your
present palette starting at the index chosen.
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All yarns: Imports the full yarn palette from the import file to your present palette.

Fig. 8.3
Note: Yarns imported will overwrite present yarns in the indexes they are imported to. If you do not
want to overwrite the current palette, enter an Index Number (Import to Pallet at Index) below the
range of index numbers already in the file.
Yarn Density for Fabric View
Values entered here will have bearing on the Fabric View. For fabric simulation on the screen, the ratio
between the numbers is important. You may prefer to enter the values for the finished cloth, rather than
the values (sett) on the loom. For printing the fabric to actual scale, the numbers must be correct for the
spacing in the cloth to obtain the scale.
Set up thick and thin threads for a repp weave, for diversified plain weave, or other weaves. Check the
Use Density from the Yarn Info box in View/Fabric Options, to use these individual yarn settings
instead of the general density settings in View/Fabric Options. The size and spacing depends on the
yarn, the sett and type of weave. Suggestion: Wind yarn to cover an inch/cm on a ruler to help decide the
Yarn size/grist to enter.
Yarn Space = Yarn Diameter
Do not enter the number of ends per inch or the denier or gauge of your yarn, but rather the amount of
space it will occupy. This number relates more to the sett, or the number of ends/picks as will be in the
finished textile
.
Supplementary Yarn
A supplementary thread is a thread that floats over, and under, ground threads. It does not have a space of
its own and does not add to the width or length of the cloth. For weaves that use supplementary yarns,
check the Supplementary Yarn box in the Yarn Dialog while entering the other information for the
specific yarn.

8-3

To enable the Supplementary Yarn feature, select Auto mode in View/Fabric Options/Fabric View
Mode/Auto Yarn Data. Set the Ends and Picks density for the ground weave in View/ Fabric Options.
This will allow the Supplementary Threads to float over and under the ground weave. Do not select the
Use Density from Yarn Info box. You can use a Supplementary Yarn in parts of the fabric, as opposed
to selecting Warp Faced or Weft Faced, which works best for fabrics that are uniform throughout.
Weaves with overshots and Summer & Winter show well when the Supplementary Yarn feature is
utilized.

Edit Colors
This menu selection will open the Edit Colors dialog box. Please refer to Chapter 11, Working With
Colors, for more information.

Color Palette
This menu selection will open the Color Palette dialog box. Please refer to Chapter 11, Working With
Colors, for more information.

Color Dialog
This menu selection will open the Color Dialog box. Please refer to Chapter 11, Working With Colors,
for more information.

Please refer to Chapter 3, on the View Menu, for further information on the Fabric Simulation
feature.
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OPTIONS MENU
To choose more options than are available in the New Pattern window, go to the Options Menu/Options
submenu. The Options window has five tabs that you can choose from to set specific parameters: Loom, Style,
Layout, Grid, and Miscellaneous.

OPTIONS/Options
In each of these Tab boxes, if you change a setting, the Apply button will activate for you to see the
effect of the changes prior to closing the box (OK button). Click the Help button in any of the five tab
views to open the Help dialog window.
OPTIONS/LOOM Tab

Fig. 9.1
Pattern Size
Select the size of your fabric. The default size is 2400 ends and 2400 picks. This is the same as the maximum
size in Design Mode. The maximum size in Draft Mode is 9600 ends and 9600 picks. Maximum number of
Treadles and Shafts is 128.
Shafts and Treadles
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If Liftplan is selected, these will be greyed out. Select number of Shafts and Treadles. The maximum for each
is 128.
Loom System
Select Liftplan or Tie-Up Mode.
If you have a pattern on screen, it will automatically be converted. If changing from Liftplan to Tie-up and the
pattern contains more than 100 different lags, the exceeding part of the pattern will be corrupted. Patterns are
saved with information about the loom system used and when retrieved, the loom system will be set accordingly.
Treadling
If you are in the Tie-Up and Treadling Mode, you can select Single or Multiple Treadling. If you are in Liftplan
mode, this option is grayed out.
Note for Multiple Treadle settings: when in Liftplan and Single Tie-Up Mode, there is a strict and always exact
relationship between the draft and the drawdown; but the Tie-Up Multiple Treadles Mode can be ambiguous as it
allows a shaft to be set to be both up and down at the same time and thus makes it your own responsibility to
make a correct pattern. Because of this, Drawdown and Design editing is not available in Multiple Treadles
Mode and also several other menu items will be disabled. Use this mode only when you need to press more than
one treadle for each pick as when using a skeleton tie-up.
To Make Patterns for a Drawloom, select the Liftplan mode and the number of Shafts you want to use in your
pattern threading. Also, it is preferable to select Rising in the Shed options.
First, fill in the threading. Then draw your pattern in the drawdown. Your pattern will automatically be created
in the Liftplan as you create it. Print out the liftplan for use when lifting the pattern shafts or units at a drawloom.
Shed
Choose between Rising and Sinking Shed. With Rising shed, a filled square in Liftplan or Tie-up indicates that
the selected shaft/harness will rise, so that a warp thread will pass over a weft thread in the drawdown. With
Sinking Shed, a filled square indicates a weft thread passing over a warp thread; the selected shaft/harness will
lower.
Your choice of Rising or Sinking Shed is displayed in the Status Line of the Draft window.
Normally Sinking Shed is used with countermarch and counter balanced looms and Rising Shed with dobby
looms, jack looms, table looms and other rising shed looms. Patterns are saved with information about the shed
system used and when retrieved, the shed system will be set accordingly.

OPTIONS/Style Tab
Drawdown Style
In Draft Mode, you can select to have the drawdown represented in one of four different styles. The Normal style
is the plain style in effect when you start the program. Grid will display the pattern with a grid outline, as when
designing on graph paper. This style lets you see each square more clearly. Thread puts space between each
exposed end, giving the image of a loosely woven cloth and lets you visualize the interlacing of warp and weft
threads. Threads Outlined enhances this effect, with a small outline around each overshot/float.
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All commands works the same way with all styles. Be aware that the screen is updated more slowly when the
Thread style is selected. You will notice this especially when working at lower zoom levels.

Fig. 9.2
Use Grid Style in Design Mode
It is recommended to have this option selected. It gives you a scale reference when drawing in a Design Mode.
Otherwise, it resembles a lined sheet of paper, rather than graph paper. Once your pattern is entered, you can
select Thread style to better see the yarn/placement.
Threading Position
Select to position the Threading Grid at the top or bottom of the screen. Note that this setting will also affect the
manner in which the Treadling or Liftplan grid will be shown. When the Threading is at the top, column 1 in the
Tie-up /Treadling grid will be at the left side of the Treadling column. With the Threading at the bottom, column
1 in the Tie-up /Treadling grid will be at the right side - according to the European tradition. Remember, columns
of Liftplan and Tie-up will correspond to the appropriate harnesses, depending on the settings selected in the
Layout/Tab Window.

Show Structure
You can select to Show All, a Repeat, or a specific area of the cloth. Showing the first repeat as structure is
typically useful in an educational situation. The structure area selected will be saved with the pattern. The
structure colors are white and a selected color. Click the Structure Color Box to change the color.

OPTIONS/Layout Tab
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Fig. 9.3
Threading Start Position
There are two selections to make for your Threading layout:
1. Top or Bottom: Select Top if you want your first Harness to be the uppermost line in the Threading Grid.
Select Bottom if you want your first Harness to be the lowermost line in the Threading Grid.
2. From Right or From Left: Select From Right if you want your first warp thread (end 1) to start from the right
side. Select From Left if you want your first warp thread (end 1) to start from the left side.
Treadling Start Position
Select From Left if you want your first shaft to start from the left side. Select From Right if you want your first
shaft to start from the right side. When in Liftplan, the Treadling Start Position selection will be grayed out.
Treadling/Liftplan Start Position
Select if you want the first pick to be at the Top or at the Bottom of your liftplan/treadling. Having the first pick
at the bottom is like seeing the cloth on the loom, with the first weft placed accordingly.
Note: The Fabric and Interlacement views are always displayed with Pick 1 at the bottom of the screen. If you
want to see your fabric from the top down, just change to a low zoom level (unless you have a very large
file/image) or you can select View/Fabric Window , to see the full cloth image. You can also turn the fabric
upside down with Reverse Weft Order from the Utilities Menu.
Yarn Colors in Grids
If this is checked, the designated yarn color will fill the grid box signified for a particular warp end (see the Yarn
Info Dialog Box). If the Circle Symbol is being utilized, the color will fill the little circle, otherwise the Symbol
will be surrounded by the color.
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Numbers in Grids
Numbers will appear in the Threading, Treadling/Liftplan and Tie-up grids if this box is checked, but only at
zoom levels 8 and above. Below zoom level 8, the usual filled squares will be used. Numbers in Grids can be
combined with Yarn Colors in Grids, in which case the color will surround the numbers.

OPTIONS/Grid Tab
Marking Lines
Select the Use Marking Lines box to make the other options available. Full Marking Lines means that,
depending on the intervals you have chosen, certain horizontal lines in the Liftplan/Treadling and vertical
marking lines in Threading grids will show. If this box is left unchecked, only vertical marking lines will be
visible.

Fig. 9.4
Numbers by Marking Lines
When checked, this option will insert numbers next to the Marking Lines along the Threading and
Treadling/Liftplan. The numbers next to the marking lines are available in Zoom Level 7 and up. The numbers
are larger at higher zoom levels. In Print/Draft and Export/Save Draft as PNG-image, you can select/unselect
to print the numbers.
Marking Line Interval
Choose intervals for the placement of visibly distinctive marking lines at specific intervals in ends and picks.
See Grid Line Color and Marking Line Color.
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Get Repeat Button
You can use this to visually mark a repeat by setting the intervals equal to the repeat size. This button is included
to quickly set the marking lines to the repeat size.
Grid Line Color
Select the color for the overall grid in Threading and Treadling/Liftplan.
Marking Line Color
Select one of these color options to highlight the Marking Lines that you defined n the Interval Box.

OPTIONS/Miscellaneous Tab

Fig. 9.5
Unit of Measure
Select the unit of measure for the Fabric Density setting.
Warp Empty Ends in Analysis
Fill empty ends and picks in the threading grid, and also the treadling grid when in tie-up mode, after fabric
analysis. Fabric analysis takes place when you change from Design Mode to Draft Mode and when you select
Re-Analyze Shafts or Re-Analyze Treadles. Empty ends and picks are threads that do not form any interlacement
with other threads. They will occur if you draw a motif on a plain background in Design Mode.
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Show All Warning Messages
Uncheck this option to display fewer warning messages.
Save Layout Options in WPO Files
When this option is checked, layout positions will be saved in the file as formatted in the various Options dialog
windows. When a file which includes layout positions is opened, it will be displayed in accordance with the
positions saved in the file. If the file does not contain position data, it will be displayed according to the present
settings in the program. Layout positions are the start positions in the grids and the threading grid placement (top
or bottom of the screen). Saving layout positions in the files is useful if you use different positions in different
patterns or if you send patterns to someone else and want to make sure it will be displayed with the same
positions.
Save Settings on Exit
Check this option to automatically save your settings when you exit from Weave Point.
Save Settings
To save your selected settings now, choosing Save Settings on Exit will gray out the SAVE Settings bar and
ensure that your work will be saved.

OPTIONS/Zoom

Fig. 9.6
In addition to the zoom scroll bar, there is a zoom submenu and this Dialog Box. It is effective to use it when you
have large size designs and need to scroll from one side of the zoom scale to another more quickly.

OPTIONS/Note
You can write a note to accompany your pattern. The text can be whatever you want. It will automatically be
saved together with everything else.
The File Menu allows for Printing. There is an Edit Menu in the Note Window for copy, cut, and paste functions
or the shortcuts can be used.
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Fig. 9.7
To copy text in the note, press Ctrl-C. To cut, press Ctrl-X. To paste text, press Ctrl-V. You can also copy and
paste from/to other programs.
The Notes Window will float on your Draft, so that you can edit the pattern while keeping notes. The window is
also resizable.

OPTIONS/Project Planner

Fig. 9.8

This dialog box enables you to calculate the amount of materials and costs for the project represented in the
particular pattern/file. For more detailed information see Chapter 12, Project Planner.
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WEAVE MENU
Weave Menu items will allow you to select the settings to use the Drivers in the software to operate your particular
AVL Compu-Dobby. Proper connection must be made between the Compu-Dobby and your Computer. (Refer to
your Compu-Dobby manual for further information on connection issues.)
Commands may vary with different loom control drivers and different looms. Before using Loom Control, read the
manual and other information about Loom Control included on the WeavePoint CD and by the loom manufacturer.

WEAVE/Options
Selecting Options on the Weave menu will open the Weave Options dialogue box. This box will allow you to select
the correct driver by choosing your type of CompuDobby, connect with your Computer by finding and selecting the
correct Com Port, and other options that will provide tools to help you while weaving.

Fig. 10.1
Com Port
Select the Com Port from the Drop-down menu. Your computer may have pre-selected the Port, but should you
experience connection issues, you may have as many as 9 Ports to try. Please note that more ports are listed than
actual, physical ports on your computer. This is because some of the listed ports may be internal. You may have to
try several different Ports (external or internal) to find the correct one. Refer to the Device Manager in your
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computer (Start Menu/Control Panel/Device Manager/Com Ports) for more specific information as to the location
of the port involved and re-assignment of available Com Ports. See your Compu-Dobby Manual for further
information on connectivity issues and Error Recovery in WeavePoint Help (Help Menu). Use the Find Com Ports
button to help narrow your search.
The list of available Com Ports will include Serial and Serial/USB Ports 1 thru 9. If the driver has been assigned to a
port other than those, look in the Device Manager on your computer to find the correct Com Port and enter it in the
box.

Fig. 10.2
Compu-Dobby I, II, III or IV
Select Compu-Dobby I, Compu-Dobby II, Compu-Dobby III, or CompuDobby IV, depending on which
CompuDobby you have. If you are unsure, please refer to your Compu-Dobby manual. Compu-Dobby II was
introduced in 1996; Compu-Dobby III made its debut in 2001, and CompuDobby IV was released in 2009.
Connection Type
The selection of connection options will be grayed-out unless you have selected and are using a CompuDobby IV.
With this last selection, you will be able to choose what type of connection you will use with your computer.
USB - If you select to use a USB connection, the installation of a special USB driver (FTDI) will be required. This
driver will be included on your WeavePoint CD-ROM. After installation of your WeavePoint software, locate the
D.exe file for this driver on your CD-ROM and run it. It will not automatically install with the weaving software.
Please refer to your CompuDobby IV manual for more information, or contact Customer Service at AVL Looms, Inc.
ETHERNET – The selection of Ethernet for your method of communication will require the use of the Ethernet SetUp button. Enter the IP address:169.254.128.3. This connection must be made with a crossover cable.
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If, for whatever reason, you find it necessary to go from one connection type to the other, it is best to change the
protocol, then reboot the CompuDobby IV and restart WeavePoint.
AUTOMATIC
If you have a CompuDobby IV and select, WeavePoint will try out both Ethernet (with the present IP address) and
COM ports (which includes USB with the driver), until it finds the loom or until all available options are tested.
Normally, Automatic will find the correct connection the first time Loom Control is run. This could take up to
about 10 seconds. WeavePoint will then store the connection information and use this the next time you start Loom
Control.
If connection is not obtained with Automatic, you can manually select Ethernet or Serial COM/USB. If the Com
Port is not within range 1-9, you may wish to look at the settings in the Device Manager on your computer and set
the Port number manually.
In Weave Options, you can check "Show Startup Message" to display the Start Up Message sent from the loom and
thus confirm that communication is established.
Sound at Color Change
Choose this setting for the computer to notify the weaver to change the weft color while weaving. The sound used is
the standard Windows exclamation sound. Note that this sound can be changed in the Control Panel Sounds to any
sound you like.
Check the settings in Sounds in the Control Panel. Is any sound assigned to Exclamation? If not, select a sound.
Then test the sound with Preview. (If there are no loudspeakers, there may still be a simple beep.)
Then make sure that the volume on your computer is turned up.
Disable Screen Saver
It is not desirable to have your weaving interrupted by the screen saver. You may weave for a long time without
touching the mouse or the keyboard and then the screen saver will start if it is not disabled. Making this selection will
automatically keep the screen saver disabled when in loom control mode. Each time you exit from weaving, the
screen saver will be re-enabled. And don't worry about your screen. It can take long hours of weaving without any
sign of damage.
Use Grid Color Settings
Select this box if you want the Grid Color Settings in your Draft Window to be reflected in the Loom Control
window, too.
Show Numbers in Liftplan
Select this box to replace the black squares in the liftplan with numbers.
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Rug Loom
If you are operating an AVL Rug loom, you must make this selection. It affects the timing of the solenoids with the
movement of the Slide Bar in the Dobby Box.
AVL 40
This box should be selected only if your AVL loom has 40 harnesses.

Weave/Loom Control (AVL Looms)
The Loom Control dialog box lets you select the Start Pick (default is pick 1) and the End Pick. The End Pick,
shown automatically in liftplan or treadling, is suggested according to your selection of the repeat in either the
liftplan, weft colors, or the total repeat mode.
It is important to select Total Repeat if you work with complex color sequences and especially if their repeat is not
matching with the liftplan repeat. Since your computer will give you a sound signal when to change the weft
color, it is important to have an accurate repeat according to both color and structure. Total Repeat is the minimal
repeat one has to select to get the design repeated completely, including color and pattern.

Fig. 10.3
For example, if the liftplan repeat is eight picks and the weft color repeat is twelve, the total picks in one repeat will
be 24. Total Repeat should be selected so the full range will repeat automatically when weaving.
You can override start Pick and End Pick, if you wish.
For weaving a pattern with weft borders, you can select Start Pick to be the first pick above the border.
When these selections have been completed, click OK, and the Loom Control Window will open in complete
screen mode.
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Loom Control Window
When weaving, your pattern will be displayed in a special weaving mode in an enlarged scrolling grid. This
makes it easy to follow the pattern on the screen, even from a distance.

Fig. 10.4
Loom Control Window
The arrow at the right side of the scrolling grid/Liftplan and Drawdown indicates the fell line and current pick. The
active pick number is displayed to the right of the arrow.
When you first open this window, you should hear an immediate click signaling the firing of the selected solenoids for
this pick.
The Color Indicator is the large, rectangular field located in the lower portion of the window. It shows the yarn
color to weave in the active pick.
The active pick number is repeated again, by the large number to the right of the Color Indicator.
On the upper left side of the window you can see the pattern repeat as fabric. If your repeat is short, 16 for
example, it will be a narrow horizontal selection of your pattern. The longer your repeat, the more will be shown,
but the view will be limited to the range allowed in the upper left corner. It will scroll as you progress through your
extended pattern.
Status bar
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The status bar is located at the bottom of the window. Here you can see the total number of picks in the repeat to
weave, the total number of picks you have woven since you started the present weaving session and the next, present,
and last picks, and the position of the cursor if it is over a shaft in the Liftplan.
If you are not able to see the Status Bar, it is probably behind your computer’s Task Bar. To hide the Task Bar, rightclick at an empty place on the Bar and select Properties. Then check “Auto-hide the Task Bar”.
Tool Bar
There are a series of Arrow Buttons and Command Buttons at the top of the window, in the Tool Bar.
The two arrows inside the squares will Advance the Scrolling Grid, as currently displayed in the window, to
the complete next page of the pattern.
The two Up and Down Arrows will cause the next pick to move up or down as you select, and the number of
the next selection is always reflected in the between the two sets of arrows. You can also press the page up and
page down keys on your keyboard. Please note, though, that the screen won't update until the next time you treadle.
The little curved arrow will send you back by one pick. The keyboard shortcut is “B”.
The six Command Buttons are as follows: (To issue most of the following commands, you can either click the
screen button or the button on the loom control box.)
Reverse
Change Reverse/Forward weaving direction. When Reverse is in effect, a large, red arrow will appear to the right
of the Active Pick number in the lower right corner. The keyboard shortcut is “R”.
To avoid skipping any picks, it is important that Reverse is only selected while the shed is closed.
Go To
Click this button to open a window, in which you can specify the next pick by its number.
Prior to this command, insure that you are not weaving in Reverse and tabby weaving is turned off. The keyboard
shortcut is “G”.
Tabby (Plain Weave)
Change to tabby (plain weave) weaving. Click the tabby button again to leave tabby weaving and return to your
pattern.
When weaving tabby, the two tabby lags are called A and B in the status bar for Next, Present, and Last. These tabby
picks will be counted separately from your other pattern, as long as you are in Tabby mode.
When Tabby is in use the arrow buttons are not be available. The keyboard shortcut is “T”.
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Edit Tabby
This will open a box which will enable you to adjust the tabby for your pattern/threading, to diminish overshots in
the tabby. Use your cursor and right click to make any changes.

Fig. 10.5
Save
Save your present pattern and weaving position. When save, you can later choose Resume to continue
weaving the same pattern. The present position, repeat range, and weaving direction will be stored.
Note that the present pattern will be saved to disk like an ordinary WeavePoint pattern. You can open and
edit this pattern also when not weaving. Any changes you make to the pattern will be used when you
resume.
Skip
Skip one pick. This command is only available at the loom control box for Compu-Dobbys I and II.
Close
Click Close to quit the loom control window.

Weave/Resume
When weaving, before closing the Loom Control window you can click Save to store the present pattern
and weaving position. Later, you can then just click Resume on the Weave Menu to open the same
pattern and resume weaving where you left off last time.

Weave/Cartridge
You must be in Liftplan Mode for Cartridge Programming.
You can store patterns in the cartridge inserted in the Compu-Dobby box. Then you can weave without
having the PC connected to the loom.
The Cartridge dialogue will show the present patterns stored in the cartridge by index number, name, and
number of picks. You can put your present liftplan in the cartridge or load a liftplan from the cartridge.
With Compu-Dobby II, you can store ten patterns. With Compu-Dobby I, you can store five patterns.
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If the cartridge memory for some reason is corrupted, you will get a message and the option to erase the
cartridge contents. It is then recommended to click Yes to erase the cartridge and reset the cartridge
memory. If it is important to access any pattern stored in the cartridge, you can click No and then try to
load the pattern from the cartridge.
Put Liftplan
Select the pattern index where you want the liftplan to be stored. If choosing an index where a liftplan is
already stored, the new liftplan will replace the old one.
Select the number of picks you wish to store, starting from pick one. Patterns number 1 and 6 can
accommodate up to 900 picks. Patterns 2-5 and 7-10 can accommodate up to 445 picks.
If you try to save a design in a tie-up mode, you will get a warning message to transform it to a liftplan
mode.
Enter a pattern name of up to twelve characters, if you did not name it before. If you did, do not change
the name here. Use the same name. Click OK to store the liftplan in the cartridge.
Get Liftplan
First, select a pattern to load by clicking its index.
Error Recovery
For CompuDobby II - when communicating with the loom controller box, errors may occur. If you ever
get an error message, you can just try to proceed if possible.
One reason for errors when starting weaving or cartridge communication would be if you pressed any of
the switches on the loom control box after turning on the Compu-Dobby power. This must not be done
before you start to weave. Your Compu-Dobby II display should be in a "waiting for computers or
switches" mode.
If errors occur, check that the cable is properly connected at both ends. And check that you have selected
the correct Com Port - being the port where the loom cable is connected to your PC.
Sometimes it can help to restart the PC and the Compu-Dobby box.
When getting the message saying that the cartridge is corrupted or missing, it indicates that something is
wrong in the cartridge memory. The cartridge battery (on Compu-Dobby I only) may need recharging.
Check that the cartridge is actually installed. CompuDobby II batteries can be replaced.
For further information, refer to your CompuDobby manual.
Step by Step Process of Weaving On-Line and with a Use of Cartridge
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First five steps are the same for both Weaving On-Line or with the cartridge. After step 5, go to the
appropriate part.
1.)
From the pull down Weave menu, select Options. From the Weave Options Window, choose
the appropriate option, e.g. Compu-Dobby I or Compu-Dobby II.
2.)

From the same Weave menu, select Com Port. Choose the appropriate Port.

3.)
Make sure that the cable connecting your computer with the Compu-Dobby is connected to the
same selected port on the back of your computer.
4.)
Click on the Sound at the Color Change if you will use more than one color in the weft and
want computer to give you the sound signal at each color change
5.)
Click on Disable the Screen Saver if you screen has one and you intend to weave on-line. You
want to be able to look at your weaving on the screen while weaving.
(If you weave with use of cartridge, go to page 11-5, step 6.)
Weaving “On Line” (without the use of cartridge)
1.)

Open your design on the screen. It can be in either Liftplan or a Tie-Up Mode.

2.)

Switch your CD box on and make sure it says “Waiting for a computer or switches”.

3.)
From the Weave menu, select Loom Control. The Loom Control dialog box lets you select the
Starting Pick and the End Pick of your weave (repeat). For the End Pick, the weft repeat will be
suggested according to your selection of the repeat in either the liftplan, weft colors, or the Total Repeat
mode. It is important to select Total Repeat if you work with complex color sequences and especially if
their repeat does not match the liftplan repeat. The Total Repeat is the minimal repeat one has to select to
get the design repeated completely. For example, if the liftplan repeat is eight and the weft color repeat is
twelve, the total repeat will be 24. Click OK.
4.)
A large window will appear on your computer screen showing an enlarged scrolling grid. A
horizontal line indicates the present pick. To the left you can see pattern repeated as fabric. You are
ready to start weaving. The display on the CD box is showing the active and the next pick.
5.)
When you want to Stop, go back to your computer and click on the Close button in the top right
corner of the displayed window.
Weaving with a Cartridge
1.)
Open your design on the screen. Make sure the draft is in the Liftplan mode. If it is not, go to
Options menu, Options submenu, Loom window. Change your Loom Systems to Liftplan. If you try
to access the cartridge while in Tie-Up mode, you will see the warning “Turn to Liftplan mode for
cartridge programming”.
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2.)
Switch your CD box on and make sure it says “Waiting for a computer or switches” and that your
cartridge is connected properly.
3.)
From the Weave Menu, select Cartridge. An AVL Cartridge window appears on the screen.
You have ten possible positions. Each liftplan will be displayed with its index number, name, and the
number of picks in that liftplan. This is an information window. From this point you can:
a.)

Put Liftplan to transfer your liftplan to the cartridge.

b.)

Get Liftplan to transfer liftplan from the cartridge back to the computer.

c.)
Close if you just wanted to see positions, index numbers, names or number of pick in
each design, but did not want to make any changes.
4.)

In your Put Liftplan window, you need to enter three parameters:

a.)
Put as Liftplan #_____. Here you decide in which position on your cartridge you want
to put this liftplan.
b.)

Determine the size of your design by entering your end pick. Start pick is always 1.

c.)
Enter the name of your design. If your design does not have a name, you can name it
here; if it does, it has to be exactly the same. If you change the name of your design, it might not save it
correctly. Click OK.
5.)
Click on the Select button on your CD box to select among ten saved designs. When the name of
the liftplan you want to weave is displayed, you will also see the first pick from that liftplan and you can
start weaving.
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WORKING WITH COLORS
Colors from the Library
There is a very fast way to assign one or two colors to your warp and/or weft using Fill Menu (See the
Fill Menu chapter).
Palettes
To access the color palette, click on the icon at the right hand side of the tool bar. The icon looks like
four windows in different colors. Once the palette is displayed, you can select the number of colors
viewed in the Palette Window by clicking on the Current Color bar at the bottom of the palette. The
smallest size palette has 16 colors, then 64, and the largest one has 256.
The bar at the bottom of the palette is showing you which color is active and the same color is displayed
at the tool bar, next to color palette icon, in your general window.
Yarn colors are set in the warp color and weft color grids along the threading and liftplan or treadling.
You can use up to 256 colors in one pattern. Each color has a color index number, ranging from 0 to 255.
Each color index can be adjusted to any color you wish within a range of more than 16 million hues and
shades. You adjust a color in the Color dialogue.

Fig. 11.1
Think of it this way: In the color grids you select different yarns. In the Color dialogue, you dye the
yarns. The great advantage when simulating a fabric on the computer screen is that you can dye the yarns
even after the cloth is woven.
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The current color to draw in the warp and weft color grids is always displayed in the Color Box in the
status bar. Click the color box to select another color. To easily see and select many colors, choose
View/Color Palette. The color palette floats on top of the main window.
To quickly select a color already in use, right click on it in the warp or weft color grid. Note that you
cannot “erase” a color, as there is no specific background color (white is a color like any other color).
To edit many colors or make your own palette, the Edit Colors window offers many extra options.
The Color Dialogue
Double-click a color box in the Color Palette or Edit Colors window to bring up the Color dialogue to
adjust the color. Double click on a white square to create a new color for the pallet.

Fig. 11.2
Color Dialogue Box
Whatever color you are selecting with the cross hairs will be shown in the Color/Solid box. Drag the
little arrow up and down along the color bar on the far right to change the value of your color. Create a
new one and click OK and the pre-selected white square will be filled with the new color. If you are
adjusting a color, just click OK and the color change will be reflected in pre-selected square.
Note: the Custom Colors field is not used by WeavePoint. You can use it to compare colors if you like,
but the custom colors will not be there the next time you open the Color dialogue. So, do not use the Add
to Custom Colors button.

Yarn Menu/Edit Colors
Selecting Edit Colors on the Yarn Menu will open the Edit Colors Dialog Box. This box will enable
you to design and view multiple color-ways for your textile, all in one place.
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You can select to display 16, 64, or 256 colors. Note that there are always 256 colors available and the
full 256 color palette will be stored when saving a pattern. The 16 color window will only show one color
way. If you are working with a few colors, you may find it easier to see them with only sixteen colors on
display.
OK will close the window and save the changes made.
Cancel will close the window, saving no changes.
Revert will undo what changes you have made since opening the Edit Colors box.
Help – Click on the Help button to open the Help dialog box, with immediate access to the Edit Colors
information.
At the left side of the color grid, there are seven small, gray buttons. Clicking one of these buttons will
move that row to the top row.

Yarn Menu/Edit Colors

Fig. 11.3

This can be used to let each row be a colorway for your fabric. This way you can make up to eight
colorways, each up to eight colors in a 64 color display or up to sixteen colors with a 256 color display.
To set up several colorways, first fill in the warp and weft colors with colors from the top row of the
palette, using color index 0-7 (15 with 256 color display). Then fill the second row with a new colorway,
then the third and so forth. Click the small buttons to the left of each row to switch quickly between
colorways. The selected color way will move to the top row in the window and the changes will be seen
in the Draft window immediately.
Changing Colors
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Clicking on a particular color box will surround that box with a black square. Select the color and it will
he displayed at the bottom of the window in the large rectangular panel on the left hand side with the
index and RGB values for that particular color. Click on the rectangle and the Color Dialog Box will
open, allowing for color adjustment.

Switch
Once highlighted, you can enter the selected color into one of the two smaller squares to the right of the
rectangle. Select a second color and click to fill the second small square. These two colors can now be
switched in the selected color way when clicking Switch.
Blend
If the two selected colors are at the beginning and end of the same color way sequence, click the Blend
button and the colors in the 2, 6, or 12 boxes between them (depending on the number of colors
displayed) in the color way will change to reflect a gradual blend from the first color to the last. The
number of color blends between two selected colors will be determined by the position of these two
colors in the color palette. If they are only two spaces apart, the two colors in between will be blended. If
color one was the first color in the grid (index 0) and the second selected color was the last color in the
grid (index 255), the entire color palette will be showing blends between these two colors.
Copy
If you wish to substitute a color in one color way for one in another, place the color you wish to change in
one box and select the desired color and place it in the other. Click Copy and the change will be affected.
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